CellQuest Software Reference Manual

Manual Part Number: 11-10865-01    Rev B
January 1998
CellQuest Software Reference Manual

Copyright

© Becton Dickinson and Company, 1997. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in retrieval systems, or translated into any language or computer language, in any form or by any means: electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior written permission of Becton Dickinson Immunocytometry Systems, 2350 Qume Drive, San Jose, CA 95131, United States of America.

WorklistManager and LoaderManager software © Becton Dickinson and Company, 1996. This software is the property of Becton Dickinson and Company. Each sale of a stored unit of this software grants the purchaser a personal, nonexclusive, nontransferable license. This software may not be duplicated, reproduced, or copied in any form or by any means whatsoever except as otherwise permitted by law.

These programs were written with MacApp®; © 1985–1996 Apple Computer, Inc. The MacApp software is proprietary to Apple Computer, Inc and is licensed to BDIS for distribution only for use in combination with WorklistManager and LoaderManager software.

Disclaimer

BDIS reserves the right to change its products and services at any time to incorporate the latest technological developments. This guide is subject to change without notice. BDIS welcomes customer input on corrections and suggestions for improvement.

Although this guide has been prepared with every precaution to ensure accuracy, BDIS assumes no liability for any error or omission, nor for any damages resulting from the application or use of this information.

Apple Computer, Inc makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to its merchantability or its fitness for any particular reason.

Trademarks

FACS and Falcon are registered trademarks of Becton Dickinson and Company. CellQuest, FAC-SComp, FACScan, FACSort, FACScalibur, MultiSET, SimulSET, and TruCOUNT are trademarks of Becton Dickinson and Company.

Apple, the Apple logo, MacApp, and Macintosh are registered trademarks of Apple Computer, Inc.

Teflon is a registered trademark of E.I. du Pont de Nemours and Company.

Limitations

For in vitro diagnostic use.
Contents

Preface vii

Chapter 1: Introduction 9
  1.1 Requirements 10
  1.2 Installing the Software 11
  1.3 Installing Acquisition Services 14
  1.4 Launching CellQuest 15
  1.5 Quitting CellQuest 17

Chapter 2: Becoming Familiar with CellQuest Software 19
  2.1 The Experiment Document 20
  2.2 File Menu 24
  2.3 Edit Menu 28
  2.4 Windows Menu 34
  2.5 Tool Palette 39
  2.6 Using Experiment Documents as Templates 42

Chapter 3: Preparing for Acquisition 43
  3.1 Creating an Acquisition Plot 44
  3.2 Using the Acquire Menu Commands 47
  3.3 Using the Cytometer Menu Commands 61
  3.4 Sorting with FACSCalibur or FACSort 67
  3.5 Using the FACS Vantage 69
CellQuest Software User’s Guide

3.6 Using the FACStarPLUS .................................................. 75
3.7 Checking Cytometer Status ........................................... 79

Chapter 4: Acquiring Data .................................................. 81
4.1 Starting Acquisition ....................................................... 82
4.2 Displaying Live Statistics .............................................. 84
4.3 Using Acquisition to Analysis Plots ................................. 86
4.4 Using Time-Dependent Plots .......................................... 88
4.5 Ending Acquisition ....................................................... 89

Chapter 5: CellQuest Plots .................................................. 91
5.1 CellQuest Plots ............................................................ 92
5.2 Creating CellQuest Plots ............................................... 95
5.3 Formatting CellQuest Plots ............................................ 97
5.4 Changing the Axes of a Plot .......................................... 107
5.5 Changing Data Files .................................................... 107
5.6 Displaying the Next or Previous Data File ....................... 108
5.7 Batch Menu ............................................................... 113
5.8 Adding Text in an Experiment Document ....................... 116
5.9 Zooming a Plot .......................................................... 119

Chapter 6: 2D Statistics ...................................................... 121
6.1 Quadrant Markers ....................................................... 122
6.2 Displaying Statistics .................................................... 124
6.3 Editing Statistics ........................................................ 126

Chapter 7: Histograms ........................................................ 133
7.1 Creating Histograms .................................................... 134
7.2 Creating Overlaid Histograms ........................................ 137
7.3 Using Histogram Tools ................................................ 143
Contents

Chapter 8: Histogram Statistics ....................................................... 147
  8.1 Log Data Units ................................................................. 148
  8.2 Calculating Means .......................................................... 150
  8.3 Histogram Markers .......................................................... 150
  8.4 Displaying Histogram Statistics ....................................... 156
  8.5 Editing Histogram Statistics ........................................... 157
  8.6 Overlaid Histogram Statistics ........................................... 160

Chapter 9: Regions and Gates .......................................................... 167
  9.1 Histogram Regions ........................................................ 168
  9.2 Rectangular, Elliptical, and Polygonal Regions ..................... 169
  9.3 Displaying a Region List ............................................... 174
  9.4 Deleting a Region ........................................................ 175
  9.5 Copying and Pasting a Region ........................................ 176
  9.6 Renaming a Region ....................................................... 178
  9.7 Defining a Gate ........................................................... 179
  9.8 Displaying a Gate List .................................................. 181
  9.9 Using Multicolor Gates for Dot Plots ............................... 183
  9.10 Recalculating Data ...................................................... 185

Chapter 10: Quantitative Calibration ................................................ 187
  10.1 Brief Overview of Quantitative Calibration ......................... 188
  10.2 Setting Up CellQuest for Quantitative Calibration ............... 189

Appendix A: Tutorial ..................................................................... 195
  A.1 Dot-Plot Analysis .......................................................... 196
  A.2 Histogram Analysis ....................................................... 207
Preface

CellQuest™ software allows you to acquire and analyze data from your flow cytometer on a Macintosh® computer. Working in the CellQuest Experiment window, you can create several types of plots, including multicolor contour plots and overlaid histograms, and generate statistics for dot plots, histograms, density plots, and contour plots. The versatile graphic tool palette helps you produce presentation-quality documents. You can also save everything in an Experiment document, including plots, statistics, annotations, regions, gates, markers, and color palette, and restore it all later. CellQuest Experiment documents save a reference to the data files in an experiment, not the actual data files themselves.

How to Use This Guide

The CellQuest Software Reference Manual assumes you have a working knowledge of basic Macintosh techniques. If you are a new user of the Macintosh computer, begin with the tutorial, Macintosh Basics, found in the Getting Started guide that came with your computer. Detailed information about the Macintosh computer can be found in your Macintosh user’s guide.

In addition to the written documentation, a ReadMe file was copied to your hard disk during installation of CellQuest. This text file contains late-breaking information that is not printed in this reference manual.
Conventions Used in This Guide

() Include the names of keyboard keys, for example (⌘).

Bold Indicates actions or steps to perform.

NOTE Points out additional information that may be helpful, or hints for better or easier operation.

⚠️CAUTION Alerts you to situations that could result in computer damage, failure in a procedure, or possible incorrect data results.

Help!

For technical questions or assistance in solving a problem:

1 Read the section of the manual specific to the operation you are performing. The table of contents and index should be helpful in locating this information.

2 US customers call the Becton Dickinson Immunocytometry Systems (BDIS) Customer Support Center at (800) 448-BDIS (2347). Customers outside the US contact your local Becton Dickinson Service Representative or distributor.
1

Introduction

- requirements for running CellQuest
- installing CellQuest and Acquisition Services
- starting and quitting CellQuest
1.1 Requirements

Hardware

CellQuest is fully supported on any Macintosh computer system purchased through Becton Dickinson. Other platforms may also be supported; contact your Becton Dickinson Sales Representative for detailed information. In addition, you need the security module provided with CellQuest.

CellQuest can be used on the following flow cytometers from Becton Dickinson: FACScalibur™, FACScan™, FACSsort™, FACStarPLUS™, or FACS Vantage™. (FACStarPLUS™ acquisition is only supported on the Quadra 650).

⚠ CAUTION: If you have a modem on your system, BDIS recommends that it be turned off while running our software.

Software

CellQuest requires version 7.5.3, or other versions qualified by BDIS, of the Macintosh system software with background printing turned on. In addition, BDIS recommends file sharing be turned off during acquisition.

CellQuest acquisition on a PowerPC also requires that Acquisition Library (AcqLib PPC) and the BDPACDriver are present in the Extensions folder, BDPAC is in the Control Panels folder, and the BDPACInit file is in the Startup folder.
Chapter 1: Introduction

CellQuest acquisition on the Quadra 650 requires the BDMAC be present in the Control Panels folder.

These items are installed by Becton Dickinson for both computer platforms.

⚠️ CAUTION: BDIS has tested many common INITs and they do not adversely affect software performance; however, some INITs may interfere with the software. Therefore, BDIS does not recommend installing additional INITs.

**Data Files**

CellQuest analyzes list-mode or histogram data files produced by CONSORT™ 30, FACScan Research, FACStar™ PLUS Research, LYSYS™ II, SimulSET™, or any other Becton Dickinson software except CHRONYS™. First these files must be moved to the Macintosh using either FACSNet™ Mac (or a similar network transfer product) or CONSORT File Exchange, and then they must be converted to FCS 2.0 format using FACSConvert™ software. Refer to the appropriate documentation.

### 1.2 Installing the Software

Install CellQuest software on your computer hard disk.

1. Shut down the computer.

2. Attach the security module.

   CellQuest does not launch if the security module is not attached.
The security module is packaged with this reference manual. Insert the security module in the Apple Desktop Bus (ADB) port in the back of your computer. The module does not need to be connected at both ends.

3 Restart the computer.

4 Insert the first CellQuest installation disk into the floppy disk drive.

The CellQuest disk contents appear in a window.

5 Double-click the Installer icon.

The Welcome dialog box appears.

6 Click Continue.

A window is displayed with information identical to the ReadMe file the Installer places in the BD Applications folder.

7 Click Print for a hard copy of the ReadMe file.

8 Click Continue.

A disk selection dialog appears. Choose the hard disk you want to install CellQuest software on. You may have to click the Switch Disk button until the correct disk appears in the dialog.

9 Click Install.

A dialog box appears indicating your computer will have to be restarted after installation is complete. A restart is necessary to detect the EvE INIT the Installer places in the Extensions Folder in the System Folder. This INIT is necessary to run CellQuest on both a PowerPC and Quadra 650 computer.
Chapter 1: Introduction

10 Click Yes to begin standard installation.

A dialog box describing the status of the installation appears. Insert Disk 2 when you are instructed to do so. The Installer:

- creates the BD Applications folder on your selected hard disk.
- loads the CellQuest Folder containing the application and all support files into the BD Applications folder.
- removes existing versions of CellQuest, provided you have not renamed the application or moved it from the CellQuest folder.
- creates an alias of CellQuest and adds it to the Apple menu.
- copies a security module initialization file (EvE INIT) into the Extensions folder in the System folder.

The CellQuest Folder contains:

- the CellQuest application.
- a Sample Files folder containing files used in the tutorial in Appendix A and the Quantitation Acquisition Document used for quantitative calibration. See Chapter 10, Quantitative Calibration.
- a ReadMe file with late-breaking information not included in this manual. Use SimpleText™ (included by the Installer) to open the ReadMe; the information is identical to what appeared in the window in step 6.

Figure 1-1 illustrates the contents of the BD Applications folder and CellQuest Folder.

To stop installation, press the Command key and the period key (.) Click Quit when the Standard Install dialog box appears. You will have to use the
Finder to remove any files and folders that were copied onto the hard disk before installation was stopped. Refer to your Macintosh user’s guide.

Figure 1-1  File contents, BD Applications folder and CellQuest Folder

You can choose which items you want to install by clicking Custom in the CellQuest Standard Install dialog box. When the Custom Install window appears, choose any or all of the following:

- the EvE INIT (the latest version)
- Sample Files (for the tutorial and quantitative calibration)
- CellQuest only (without Sample Files)
- SimpleText

Click on the custom item you want or hold down the shift key while you select more than one item. Click Install to proceed with the Custom Installation.

11  Click Quit or Restart when you see a message reporting a successful installation.

1.3 Installing Acquisition Services

All BDIS applications that acquire data from a flow cytometer require acquisition services. See Section 1.1, Requirements, for a description of these services for both the PowerPC and the Quadra 650 computer. These services are
installed by BDIS. If, however, it is necessary for you to install these items, follow these steps:

1. Insert the BD Insts disk in the floppy disk drive.
2. Double-click the Installer icon.
3. Follow the instructions on the screen.

The Installer will install only to the active startup disk.

4. Click Restart when installation is complete.

1.4 Launching CellQuest

Remember, CellQuest will not start without the security module attached. Launch CellQuest any one of five ways:

1. Choose CellQuest from the Apple menu. CellQuest opens with a new, untitled Experiment document.

2. Double-click the CellQuest application icon in the CellQuest folder on your hard disk. CellQuest opens with a new, untitled Experiment document.
3 Double-click a saved CellQuest Experiment document. CellQuest opens with the saved Experiment document.

4 Double-click a saved CellQuest FCS data file or exported statistics file. CellQuest launches, but neither the file nor the statistics is opened. You must open an Experiment document to use the program.

5 Drag one or more CellQuest Experiment documents onto the CellQuest application icon. This launches CellQuest and allows you to open several Experiment documents at one time.

Registering the Software

When you launch CellQuest for the first time, the Registration dialog box appears.

```
Registration Information:

User: 
Institution: 
Serial Number: 

The serial number is shown on your Product Registration Card. Remember to fill out and send in the card, retaining your copy.

Quit  Save
```
1 Type your name, your institution's name, and the serial number located on the Product Registration Card.

The Registration Card is in the front of this reference manual. The number must be entered exactly as it appears on the card. Do not use spaces in the serial number.

2 Click Save.

CellQuest is launched.

If you incorrectly enter the serial number, an error message appears. Click OK, and re-enter the number. If registration problems persist, call the BDIS Customer Support Center at (800) 448-BDIS (2347) in the US. Customers outside the US, contact your local Becton Dickinson Service Representative or distributor.

1.5 Quitting CellQuest

There are two ways to quit CellQuest:

1 Choose Quit from the File menu.

2 Hold down the Command key (⌘) while you press the Q key (⌘Q).
CellQuest Software Reference Manual
Becoming Familiar with CellQuest Software

- the Experiment document
- CellQuest-specific File and Edit menu commands
- Windows menu
- tool palette
- using Experiment documents as templates
2.1 The Experiment Document

The CellQuest document you use to create plots for acquisition and analysis, show statistics, and enter text is called an Experiment document. Each Experiment document has its own set of regions, gates, and colors that can be applied to plots and statistics.
Chapter 2: Becoming Familiar with CellQuest Software

Views

The plots and statistics that appear in an Experiment document are collectively referred to as views. Views appear in three different states: active, selected, or deselected.

**Figure 2-1** Active view (plot)

**Figure 2-2** Selected view (plot)

**Figure 2-3** Deselected view (plot)
CellQuest Software Reference Manual

- Active view is the target of any action you take. To make a view active, click anywhere in the view except on the frame. The border around the view is grayed and any commands you choose affect only that view. For example, if you make a plot active then choose Select All from the Edit menu, everything within that view, such as markers or regions, becomes selected. On the other hand, if no views are active and you choose Select All, all views become selected.

- Selected view has a black handle on each corner and has many properties of an active view, but only a selected view can be deleted, resized, or moved. Only one view can be active at a time, but multiple views can be selected. To select a view, click its frame. To select more than one view, click each frame while holding down the `shift` key or click in the Experiment document and drag the cursor diagonally to surround the views. To select all views, choose Select All from the Edit menu; make sure no views are active before choosing Select All.

- Deselected view has a clear border. To deselect an active or selected view, click anywhere outside the view.

Menu Bar

The menu bar displays the Apple menu and the CellQuest menus with the commands you will need to operate the software.

![Menu Bar](image)

Choose the About CellQuest command on the Apple menu () to display the copyright notice and the version number of the software. Click anywhere in the display to remove it. For detailed information on how to use most of the items in the Apple menu, refer to your Macintosh user’s guide.
Chapter 2: Becoming Familiar with CellQuest Software

Ribbon

Near the top left of the Experiment window is a ribbon that shows the cursor coordinates in a plot.

![X: Y:](image)

It is often helpful when you create markers or regions to know the cursor coordinates.

- When the cursor is on a histogram, the ribbon displays the channel number or linear value of the x-axis (X) and the event count (Y).
- For overlaid histograms, the Y value is blank.
- When the cursor is on a dot, density, or contour plot, the ribbon displays the channel number or linear value of the x-axis (X) and the y-axis (Y).

Tool Palette

The tool palette appears when you open an Experiment document. Use the tools in the palette to create plots, regions, markers, and text.

Size Box, Title Bar, and Zoom Box

- Use the size box, located in the lower right corner of the Experiment document window, to drag the window to the desired size.
- The title bar displays the name of the Experiment document.
- Use the zoom box, located in the upper right corner of this window, to open it to maximum screen size.
2.2 File Menu

The following File menu items are specific to operating CellQuest software.

<table>
<thead>
<tr>
<th>File</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>⌘N</td>
</tr>
<tr>
<td>Open...</td>
<td>⌘O</td>
</tr>
<tr>
<td>Close</td>
<td>⌘W</td>
</tr>
<tr>
<td>Save</td>
<td>⌘S</td>
</tr>
<tr>
<td>Save As...</td>
<td>⌘S</td>
</tr>
<tr>
<td>Save FC5 File...</td>
<td></td>
</tr>
<tr>
<td>Export Statistics...</td>
<td></td>
</tr>
<tr>
<td>Append Statistics...</td>
<td>&quot;</td>
</tr>
<tr>
<td>Document Size...</td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td>⌘P</td>
</tr>
<tr>
<td>Print One</td>
<td></td>
</tr>
<tr>
<td>Quit</td>
<td>⌘Q</td>
</tr>
</tbody>
</table>

Save

Use the Save command (⌘S) to save an Experiment document with the plots, regions, gates, colors, and statistics you created to a file on your hard disk. Instrument settings, however, are not saved with the document.

CellQuest saves a reference to the data files used in an Experiment document, not the data files themselves. If a data file used in the Experiment document cannot be found when the document is opened, a message appears.

```
"Experiment 1" uses data files that cannot be found. Use the Plot format
command to locate the files, put the files in the same folder with the
document and open it again, or use the Histogram tools command to delete
overlays that use the missing files.
```

Plots and statistic views using that data file appear without data. To prevent errors from occurring, do not delete or move data files to a different disk. If you
do move an Experiment document to a different disk, locate data files and the Experiment document in the same folder on the new disk.

**Save FCS File**

CellQuest automatically saves Flow Cytometry Standard* (FCS) list-mode files following acquisition. You can use the Save FCS File command to save the data used by the currently selected plot as a new FCS data file, without affecting the original data file.

There is no reference in the new FCS file to the original file, and the acquisition date of the new file is updated to reflect the date it was saved. Instrument settings are not saved in these new FCS files.

Plot type determines the information saved.

- Dot plot—saves gated list-mode data containing all the parameters of the original file. For example, you can analyze a four-parameter, 10,000-event file and apply a gate to include the population of interest. Assume that gate contains 3,000 events. You can save all four parameters for just those 3,000 events of interest in a new FCS file using the Save FCS File command.

- Unsmoothed histogram plot (one histogram)—saves single-parameter (SP) data containing only the parameter currently displayed in the histogram. You cannot save an SP file from a smoothed histogram.

If items are waiting to be recalculated, Save FCS File is not enabled. See Section 9.10, Recalculating Data.

**Export Statistics**

Use this command to export any combination of histogram, region, gate, and quadrant statistics as tab-delimited text to a file, with the exception of statistics

---

* FCS is a standard format for flow cytometer data files. For a detailed description of FCS 2.0, refer to Data File Standard For Flow Cytometry: *Cytometry* 1990. 11:323-333.
from overlaid histograms and the Kolmogorov-Smirnov (K-S) two-sample test. These export files can be used to transfer data to other applications, such as spreadsheet programs or databases. This icon identifies exported statistics.

An Exported Stats File

Only the statistics you choose in the Edit Stats dialog box to appear in a statistics view are exported. Missing values are represented by a period ( . ) in exported statistics. Data exported from more than one statistics view in a single Experiment document is placed in the same order these views were created. For example, if you select a Region Statistics view and a Gate Statistics view to export, the view created first in the Experiment document will be listed first in the export file.

If items are waiting to be recalculated, Export Statistics is not enabled on the File menu. See Section 9.10, Recalculating Data.

Append Statistics

CellQuest can append statistics to an existing export file if the columns to be added are the same as (or a subset of) the columns already defined for the file. If items are waiting to be recalculated, Append Statistics is not enabled on the File menu. After you open exported statistics in a third-party application to verify the data, close the file without saving changes if you intend to append more statistics to the same export file. Use a copy of the file to make changes, such as rearranging, sorting, or deleting duplications or irrelevant information.

Document Size

CellQuest sets the size of the Experiment document to a standard 8.5 x 11-inch page with 1-inch margins at the top and bottom. The actual number of pages needed to print an Experiment document is determined by the paper size.
Chapter 2: Becoming Familiar with CellQuest Software

selection and the reduction or enlargement percentage set in the Page Setup dialog box. CellQuest recalculates the minimum number of pages needed to show all the information in a document when changes are made to Page Setup. Refer to your Macintosh user's guide.

You can increase the number of pages in an Experiment document to a maximum of 20. Choose the Document Size command, make your selections in the dialog box that appears, and click OK when you are finished.

Keep the following in mind when you make your selections:

• Each square in the dialog box represents one page.

• Height and width measurements corresponding to your selection are displayed to the left of the grid.

• The number of pages selected appears in an uneditable field. CellQuest automatically adds pages to maintain a rectangular shape in the grid.

• The number of pages cannot be reduced if there is any overlapping information on the page you want to eliminate.

Print One

Use Print One to print a single copy of the currently active document. No printer dialog appears when you choose this command. Use this command only when you do not need to adjust printer specifications.
If you change your printer or printer driver, you may need to recheck the options in the Document Size dialog box and adjust the position of views with respect to page breaks in an Experiment document.

### 2.3 Edit Menu

The Edit menu contains commands that enable you to make changes to the items in the Experiment document.

<table>
<thead>
<tr>
<th>Command</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>⌘ Z</td>
</tr>
<tr>
<td>Cut</td>
<td>⌘ X</td>
</tr>
<tr>
<td>Copy</td>
<td>⌘ C</td>
</tr>
<tr>
<td>Paste</td>
<td>⌘ V</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>⌘ A</td>
</tr>
<tr>
<td>Show Clipboard</td>
<td></td>
</tr>
<tr>
<td>Text Settings</td>
<td>⌘ T</td>
</tr>
<tr>
<td>Color Palette</td>
<td>⌘ P</td>
</tr>
<tr>
<td>Banner</td>
<td></td>
</tr>
</tbody>
</table>

To use the Edit menu commands to change a CellQuest Experiment document, remember that plots and statistic views cannot be pasted into CellQuest documents; they can only be pasted into third-party applications.

Each of the following Edit menu items is specific to formatting a CellQuest Experiment document.

#### Text Settings

You can change text settings of free text, annotations, plots, and statistics views. These settings include font, style, alignment, size, background, and color. Only one set of text settings can apply to each view, except free text and annotations. In a plot, for example, you cannot have the title in one font and the axis labels in another.
You cannot change the text settings of marker, region, or gate labels and definitions.

1. Select the text or views you want to change.

2. Choose Text Settings from the Edit menu.

The Text Settings dialog box appears.

3. Choose a font and a point size from the lists.

   Scroll through the list to see the available fonts. The current choice is highlighted. The sizes available are based on the font selected.

4. Click any combination of Style check boxes.

   Check Condense to compress spacing between characters; check Extend to stretch out spacing. If both are selected, they cancel each other.

5. Click a color in the palette to change text color.
Choose from the 24 colors you set using the Color Palette. See Color Palette in the next section for details.

6 Click Opaque or Transparent to determine the appearance of overlapping text in the view.

This option applies only to free text or annotations that overlap a view. As Figure 2-4 illustrates, when Opaque is selected, the text box covers the background; when Transparent is selected, the background shows through the text field.

![Figure 2-4 Opaque background (left); Transparent background (right)](image)

7 Click a radio button under Justification to align free text or annotations in its view.

Choose Left, Center, or Right.

8 Click OK.

Color Palette

You can set and apply 24 colors to text, histogram fill, contours, overlaid histograms, and 3D plots in an Experiment document.

1 Choose Color Palette from the Edit menu.
Chapter 2: Becoming Familiar with CellQuest Software

The color palette appears. Color is not an option if you are using a monochrome or gray-scale monitor; the palette contains varying shades of gray.

2 Click the color you want to change.

The Color Wheel dialog box appears (Figure 2-5).

3 Place the cursor on the color wheel, and click the desired color.

The color wheel also lets you select colors based on hue, saturation, and brightness (HSB) or red, green, and blue (RGB) color models. Enter a number in the text box or click the up and down arrows for HSB; move the
sliders for RGB. Each color value can range from 0% to 100%. However, hue is determined by an angle value instead of % value.

![Color Wheel dialog box](image)

**Figure 2-5** Color Wheel dialog box

4 Click OK to save the new color.

The color palette appears.

5 Click Apply when you are satisfied with the 24 palette colors.

This saves the new colors in the palette, but does not close the window. Click Apply before you close the window or the color changes are lost. These color changes apply to the current Experiment document; default settings return when you open another document.

**Banner**

You can add a standard Becton Dickinson banner or a custom banner of your own design to an Experiment document. Design a banner in any graphics software and copy and paste it into CellQuest. Position the banner anywhere on the page and specify which pages of a multipage document receive the banner. The banner will never cover a view; views and windows can overlap the banner, but the banner will never overlap a view.
Follow these steps to add a custom banner to your document.

1. Create the desired banner in a third-party application and copy it to the Clipboard.

   Any graphics software that can copy items to the Clipboard as PICT will work.

2. Choose Banner from the Edit menu.

   The Banner window appears.

   ![Banner window](image)

3. Click the Custom radio button.

4. Paste the banner from the Clipboard.

5. Click Positioning to position the banner on the page.

   A dialog box appears with the banner on a scaled page. Drag the banner to position it. The time and date stamp appear if you checked them, and you can position them.
6  Click OK.

The Banner window reappears.

7  Click Apply to see the banner on your document.

This places the banner on the Experiment document, but does not close the
Banner window. Click Apply before you close the Banner window or the
banner is not applied.

The banner and time/date stamps can be positioned or removed only from
within the Banner window; they cannot be changed from within the
Experiment document itself. The time/date stamps update each time the
document is opened, saved, or printed and when Apply is clicked.

2.4  Windows Menu

The Windows menu commands allow you to show or hide the tool palette, the
Acquisition Control window, and page breaks. You can also turn on Snap to
Grid, show or hide the grid in the application window, and activate any open
window.

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Palette</td>
</tr>
<tr>
<td>Hide Acquisition Control</td>
</tr>
<tr>
<td>Show Page Break</td>
</tr>
<tr>
<td>Snap to Grid</td>
</tr>
<tr>
<td>Grid...</td>
</tr>
<tr>
<td>✓ Experiment 1</td>
</tr>
</tbody>
</table>

Hide Palette

Choose Hide Palette from the Windows menu. The tool palette disappears, and
the command changes to Show Palette. You can also hide the tool palette by
clicking its close box.
Chapter 2: Becoming Familiar with CellQuest Software

Hide Acquisition Control

Choose Hide Acquisition Control from the Windows menu. When the Acquisition Control is hidden, the command changes to Show Acquisition Control. You can also hide the Acquisition Control by clicking its close box.

Show Page Breaks

Choose Show Page Break from the Windows menu. A check mark precedes Show Page Break on the Windows menu to indicate it is chosen. This command displays page breaks and page numbers in the current document.

Figure 2-6 Show Page Break on

Choose Page Breaks from the Windows menu again to turn it off; the check mark disappears.
Snap to Grid

The Snap to Grid command affects how you create and move views by restricting cursor movement to a selected increment (inches or centimeters) within a grid. This option is helpful if you are trying to align views precisely or make them the same size. Snap to Grid does not move views automatically to align them; you cannot have two views nearly aligned and then choose Snap to Grid to align them. You must select each plot, statistics view, or text object you want to align, and then move or resize it.

Grid

If you want to display the grid in the Experiment document, set the grid size, and determine the units of measurement, use the Grid command. Grid information is saved in the Experiment document file and restored when the document is read. It will not appear on printed Experiment documents.

1. Choose Grid from the Windows menu.

The Grid dialog box appears.

* Choose inches or centimeters from the Grid Size pop-up menu; type in the grid size using the following range: 0.10 to 2.00 in inches or 0.25 to 5.08 in centimeters.

* Check Show Grid to display grid marks on the Experiment document. Choosing Snap to Grid from the Windows menu does not display the grid; you must check Show Grid on the Grid dialog box.
• Check Snap to Grid to have plots and arrows drawn in any view displayed in the Experiment document snap to the nearest grid point.

2 Click OK.

The Experiment document appears with the grid displayed as a pattern of dots.

3 Select the object you want to move.

If you click in the view with the text tool, the cursor will not snap to the grid. You must select the text object to move it; it will snap to the grid as it is dragged.

When you move an object, the upper left corner is snapped, not the other corners. If you add new plots, statistics views, or annotations by choosing a menu item, the new objects will not be snapped to the grid when they first appear; you must select each one and move or resize it.

4 Choose Snap to Grid from the Windows menu to turn it off.

The check mark is removed. Alternately, choose Grid from the Windows menu and uncheck the Show Grid and Snap to Grid checkboxes.
Viewing a List of All Open Windows in CellQuest

1. Click and hold the Windows menu title.

The names of any open Experiment documents are displayed at the bottom of the Windows menu, for example, Experiment 1 or Experiment 2.

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Palette</td>
</tr>
<tr>
<td>Hide Acquisition Control</td>
</tr>
<tr>
<td>Show Page Break</td>
</tr>
<tr>
<td>Snap to Grid</td>
</tr>
<tr>
<td>Grid...</td>
</tr>
<tr>
<td>Experiment 1</td>
</tr>
<tr>
<td>Gate List</td>
</tr>
<tr>
<td>Parameter Description</td>
</tr>
<tr>
<td>Experiment 2</td>
</tr>
<tr>
<td>Color Palette</td>
</tr>
</tbody>
</table>

All subordinate windows are listed below the name of each Experiment document, such as Gate List, Parameter Description, Color Palette. A check mark precedes the name of the active window.

2. Choose the name of any other window you want to activate from this list.

That window comes to the front.
Chapter 2: Becoming Familiar with CellQuest Software

2.5 Tool Palette

The tool palette appears when you launch CellQuest. Use the tools in the palette to create plots, regions, markers, and text.

To select a tool, click to highlight it.

To move the tool palette to a different location, click the shaded bar at the top of the palette and drag to the new location.

To remove the tool palette from the desktop, click the close box in the upper-left corner of the palette, or choose Hide Palette from the Windows menu. To make the palette reappear, choose Show Palette from the Windows menu.

A summary of the tool functions follows.
Selection tool—selects (by clicking), moves (by dragging), or resizes (by dragging) items in the Experiment document.

Contour-Plot, 3D-Plot, Histogram-Plot, Density-Plot, and Dot-Plot tools—create plots. Select the tool, click in an unused section of the Experiment document, and drag diagonally until the plot outline is the desired size. The Plot dialog box appears.

Marker tool—creates a histogram marker on a histogram plot. Select the tool, click to position the left edge of the marker, and drag to position the right edge.

Quadrant Marker tool—draws a quadrant on a dot plot, density plot, or contour plot. Select the tool, click in the plot, and drag to set the marker.

Zoom-In tool—magnifies an area of a plot. Select the tool, click in the plot, and drag to define the area of the plot you want to enlarge. See Section 5.9, Zooming a Plot.

Zoom-Out tool—returns the plot to its original size. Select the tool, and click in the plot.
Chapter 2: Becoming Familiar with CellQuest Software

Rectangular-Region tool—creates a rectangular region on a dot plot, density plot, or contour plot. Select the tool, click in the plot, and drag diagonally until the region outline is the desired size.

Polygonal-Region tool—draws a polygonal region on a dot plot, density plot, or contour plot. Select the tool, and click in the plot to establish the starting point. Move the cursor to create the next vertex and click. A line appears connecting the two points. Continue moving the cursor and setting vertices; click the first vertex to complete the region.

Histogram-Region tool—creates a histogram region on a histogram plot. These regions are created just like histogram markers. Histogram regions are used for gates; markers are used for statistics.

Elliptical-Region tool—creates a circular or elliptical region on a dot plot, density plot, or contour plot. Select the tool, click in the plot, and drag diagonally until the region outline is the desired size.

Arrow tool—draws arrows in the Experiment document. Select the tool, and click and drag the line out. Arrows must be started in an empty area of the Experiment document, but they can extend into views.

Text tool—creates or edits free text anywhere in the Experiment document. Select the tool, and click to position the insertion point. Type the text and click anywhere to complete the entry. The text wraps around after reaching a default width; to change the width, select the text and drag a handle to the desired location. To edit the text, select the text tool, click to position the insertion point, and type your changes.

Calculator tool—recalculates data. This tool is enabled only if Auto Recalculate (Gates menu) is turned off. Click the tool to recalculate data. See Section 9.10, Recalculating Data.
2.6 Using Experiment Documents as Templates

CellQuest allows you to set up generic template documents that can be reused for routine acquisition and analysis work.

1 Set up a routine acquisition or analysis document.

   The document can have a combination of acquisition and analysis plots with regions, gates, markers, statistics, colors, and banners defined. You can create a generic analysis plot by choosing the parameters and gates in the Plot dialog box and clicking OK without selecting a data file.

   If a plot has a file associated with it, make the plot generic by choosing No File in the File pop-up menu. Set up acquisition with the plots, gates, panels, parameters saved, resolutions, and number of events you want. Instrument settings are not saved when you save an Experiment document or template. See Section 3.3, Using the Cytometer Menu Commands.

2 Save the document.

   Name it a template so you remember it is not associated with any data.

3 Open the document and immediately Save As with a different name.

   This allows you to keep the original template to reuse.

4 For analysis plots, select the plots, and choose Change Data File from the Plots menu.

   Select the file you want to analyze; adjust markers and regions as necessary.

5 For acquisition plots, choose Connect to Cytometer and click Acquire.

   NOTE: You can also use the Macintosh Finder to convert a document into a Stationery Pad that can be used as a template. Refer to your Macintosh user’s guide.
Preparing for Acquisition

- supplying acquisition information
- using the Acquire menu commands
- adjusting the cytometer
- checking instrument status
- sorting with FACSCalibur or FACSsort
- using FACS Vantage
- using FACStar PLUS
- checking cytometer status
CellQuest allows you to acquire or collect data from a flow cytometer. Acquisition includes displaying data in dot plots, histograms, and density plots; displaying live statistics; selecting data using regions and gates; and collecting and storing data for all or for selected events into a data file. A data file contains the parameter measurements for each event and the instrument settings of the cytometer.

3.1 Creating an Acquisition Plot

When you initially open CellQuest, a new Experiment document appears. To perform acquisition, you must first create a plot. Histograms, dot plots, and density plots are available for acquisition and analysis; contour plots and 3D plots are available for analysis only.

1. Choose the plot type from the Plots menu.

   The corresponding plot dialog box appears. Plot dialog boxes vary depending on which plot type is chosen, but the items in the top half of the boxes are common to each. Figure 3-1 shows an example of a plot dialog box.

Alternately, you can specify the size and location of the plot yourself.

   • Select the appropriate tool (Histogram-Plot, Density-Plot, or Dot-Plot) from the tool palette.

   ![Plot Tools](Histogram-Plot tool, Density-Plot tool, Dot-Plot tool)
Chapter 3: Preparing for Acquisition

- Click in an unused section of the Experiment document, and drag diagonally until the plot outline is the desired size. The plot dialog box appears, allowing you to select an acquisition plot.

![Plot dialog box image]

**Figure 3-1** Example of a plot dialog box

NOTE: When you create a plot using the tool palette, you change the default plot size used by the Plots menu item. If you create a small plot using the tool palette, the next plot you create using the Plots menu item is the same small size.

2 Choose Acquisition from the Plot Source pop-up menu.

3 Choose the X and Y parameters.

   Click the Parameter pop-up menu to display the available choices.

4 Click OK.

   The plot appears in the Experiment document.
Changing Parameters

You can change parameters directly on any plot except overlaid histogram and 3D plots. Place the cursor over each plot axis and click the mouse button to open a pop-up menu listing the parameters. The cursor changes to the pop-up cursor whenever it is in the x- or y-axis area.

You can also change parameters by clicking the plot to select it and choosing Format Plot from the Plots menu. When the Plot dialog box appears, use the parameter pop-up menus to change the parameters. Click OK when finished.

Available Format Options

There are slight differences in the format options available for acquisition and analysis plots. The format options for each plot type are described in detail in Chapter 5, CellQuest Plots. For all acquisition plots, the Select File button is grayed. The following defines the various format options:

Dot plots

- In acquisition, select the number of dots to display (from 100 to All). For example, if you choose 100, you will see the most recently acquired 100 events.
Chapter 3: Preparing for Acquisition

- In analysis, select the percentage of dots to display (from 1% to 100%).

Histograms

- In acquisition, select the number of events to display (from 100 to All). For example, if you choose 100, you will see the most recently acquired 100 events.
- In analysis, all events are automatically shown.
- Smoothing is not available during acquisition.

Density plots

- In acquisition, select the maximum event level, or peak, of dots to display (from 1 to 999,999).
- Smoothing and thresholding are not available during acquisition.
- Probability scaling is not available during acquisition.

3.2 Using the Acquire Menu Commands

Before acquiring data, you must define what events you want to acquire, how many events to acquire, and where to store the data files. Make these choices using the Acquire menu.

NOTE: If you are using a FACSCalibur, FACSsort, FACS Vantage, or FACStarPLUS, additional menu items appear in the Acquire menu.
CellQuest Software Reference Manual

See Section 3.4, Sorting with FACSCalibur or FACSsort; see Section 3.5, Using the FACS Vantage; or see Section 3.6, Using the FACStarPLUS.

Acquisition & Storage

Use the Acquisition & Storage command to define the number and type of events to acquire.

1. Choose Acquisition & Storage.

   The Acquisition & Storage dialog box appears (Figure 3-2).

   ![Figure 3-2 Acquisition & Storage dialog box]

2. Choose an acquisition gate from the pop-up menu.

   You can choose whether to accept or reject events that fall within a particular gate. Only events that pass the acquisition gate will be received and processed by CellQuest for acquisition plots, statistics, and data storage. Figure 3-3 illustrates the different application of gates in CellQuest. Keep in
mind that the plot gate affects only the data displayed in the plot and not the data saved to a file.

![Diagram of event flow through gates during acquisition]

**Figure 3-3** Event flow through gates during acquisition

3 Choose the Collection Criteria from the pop-up menu.

Choose:

- Event Count—to acquire a certain number of events; enter a value in the *Acquisition will stop when* field (Figure 3-2). Select a gate if you want acquisition to stop when the specified number of events are in the gate. This gate is used to count events and does not gate out events. For example, if you want to acquire until you get 5000 events in G1=R1 and no storage gate is applied, the data file will contain the 5000 events as well as the events that were not in the gate.

- Event Count or Time—to acquire a specified number of events or until a certain amount of time has elapsed, whichever comes first; enter the appropriate information.

<table>
<thead>
<tr>
<th>Collection Criteria:</th>
<th>Event Count or Time ▼</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition will stop when</td>
<td>10000 of All ▼ events are counted</td>
</tr>
<tr>
<td>OR after:</td>
<td>10 seconds. Time Resolution: 10 ms ▼</td>
</tr>
</tbody>
</table>

Before every acquisition begins, CellQuest compares the number of events to acquire with the available storage space to verify there is
enough space for all data. Even when you want to acquire events based on time, you must enter a number in the event count field so CellQuest can check for storage space. If you want the collection criteria to be time, enter a number greater than you would expect to collect in this amount of time so the time will expire before the event count is reached.

- Time Resolution—for the time parameter from the pop-up menu or enter a total time for the acquisition. Time resolution is the time interval used for each channel. For example, if the time resolution is 100 ms, you see all the events acquired during a 100-ms time interval in one channel.

The total time of acquisition and the time resolution are related; you can either enter the total time of acquisition and have CellQuest calculate the time resolution, or you can choose a time resolution and have CellQuest calculate the total time. If the calculated time resolution falls between two values shown in the pop-up menu, the greater of the two values is used.

The following formula shows their relationship:

\[(\text{time resolution}) \times (1024 \text{ resolution}) = \text{total time}\]

NOTE: If you pause a timed acquisition, the saving of events to the data file is suspended, but the elapsed time continues.

4 Choose a storage gate, if desired.

Events that pass the acquisition gate and the storage gate are saved in the FCS data file. The storage gate does not affect data shown in acquisition plots.

5 Select the parameters to save and their resolution.

The resolution can be either 256 or 1024; you cannot save mixed-resolution files. Time is always stored at 1024 resolution.
Chapter 3: Preparing for Acquisition

6  Click the Parameters Saved button.

The Parameters Saved dialog box appears.

![Parameters Saved dialog box]

The available parameters depend on the cytometer type and configuration. Click the check boxes to select or deselect the desired parameters, and click OK. Only parameters that are checked in this dialog box are stored in the FCS file.

See Section 4.3, Using Acquisition to Analysis Plots, for information on using acquisition to analysis plots when a subset of parameters is saved.

NOTE: To enable the time parameter, choose Event Count or Time in the Collection Criteria field of the Acquisition & Storage dialog box.

7  Click OK.

The specified events will be saved in an FCS 2.0 list-mode file.
Parameter Description

Use the Parameter Description window to define the name and storage location of saved data files.

1. Choose Parameter Description.

The Parameter Description window appears.

2. Click the Folder button.

A dialog box appears. Navigate to the folder where you want to store the files, and click the Select button at the bottom of the dialog box. BDIS recommends that you do not save files directly to a file server or remote computer. Move them at a later time.
Chapter 3: Preparing for Acquisition

3 Click the File button.

The File Name Editor dialog box appears.

4 Choose a File Name Prefix and File Name Suffix from the pop-up menus.

The prefix can be sample ID, patient ID, or a custom prefix. The IDs are taken from the fields with the same name in the Parameter Description window. If you choose Custom, enter a prefix of up to 27 characters in the field.

The suffix can be File Count, Tube Number, or None. If you choose File Count, CellQuest appends an .nnn to the file name, where n is the number of files acquired since starting acquisition. You can change the starting number of the File Count by entering a number in the File Count field. Choose Tube Number if you are going to use a panel for acquisition. The tube number field is appended to the file name.

5 Click OK when you are satisfied with your selections.

The Parameter Description window appears with your choices in the File Name field.

6 Enter a Sample ID and Patient ID if desired.

Enter up to 27 characters in each. These IDs are saved in the data file.
7 Enter comments, if desired.

Enter up to 32,000 characters. The text automatically scrolls when it reaches the end of a line. These comments are saved in the data file.

NOTE: Some applications have difficulty processing text lines longer than 63 characters.

Custom Keywords

You can create custom keywords and export them, along with all the other statistics, to FCS data files acquired by CellQuest. CellQuest can display the first three keywords in a statistics view.

Custom keywords each start with an ampersand (&) and a number to identify them. Keywords are written to the text section of an FCS file acquired by CellQuest, and are saved in the Experiment document. If a keyword value has zero characters, the keyword and value are not written to the data file.

1 Choose Custom Keywords.

The Custom Keywords window appears.

2 Click the New button.

A new line for entering keywords is added. New keywords are automatically prefixed with an ampersand (&) and a number. There is no limit to the
number of custom keywords, but only the first three can be shown in any statistics view.

If you define duplicate keywords (name two keywords the same), the value from the newer keyword is written to the file and older values from duplicate keywords are deleted.

3 Enter a Keyword of up to 63 characters; press the Tab key to move to the next field and enter a Value of up to 63 characters.

To delete a keyword, click to the left of the & symbol in the Custom Keyword dialog box. The entire line is highlighted. Choose Clear from the Edit menu or press Delete. If you delete keywords from the list, the remaining keywords are contiguously renumbered.

Counters

CellQuest provides several different types of counters so you can monitor the progress of acquisition. Use the Counters command to display the Counters window.

1 Choose Counters.

The Counters window appears.
This window has two sizes. To resize the window, click the zoom box. The additional counters in the enlarged window apply only if you are acquiring gated data.

2 Choose the source and mode you want for each counter.

Click and hold the Source and Mode boxes to open pop-up menus of available options. You can choose among three different sources and four different modes for each counter.

Each Source corresponds to a gate chosen in the Acquisition & Storage dialog box; the gate label appears between the Source and Mode pop-up menus. If you change the gates in the Acquisition & Storage dialog box, the gates in the Counters window are updated.

For Source, choose:

- Accept—to count the events that pass through the gate specified in the Acquisition Gate section of the Acquisition & Storage dialog box. The Source reads Reject if a reject gate is set. If no gate is defined, this count is the same as the total event count.
- Collect—to count the events that pass through the gate specified in the Collection Criteria section of the Acquisition & Storage dialog box.
- Store—to count the events that pass through the gate specified in the Storage Gate section of the Acquisition & Storage dialog box.

For Mode, choose:

- Accumulate—to display a running total of the events counted.
- Rate—to display the number of events counted over one second.
- % of Total—to display the number of events counted as a percentage of the total number of events coming from the cytometer.
Chapter 3: Preparing for Acquisition

- % of Accept—to display the number of events counted as a percentage of the number of events that pass through the Acquisition Gate set in the Acquisition & Storage dialog box.

Edit Reagent List

Use the Edit Reagent List command to label parameters any way you choose. Define reagents and use them to label your samples; then combine a series of reagents into a panel. When you acquire samples using a panel, the parameter labels are automatically updated after each tube is acquired.

1 Choose Edit Reagent List.

The Edit Reagent List dialog box appears.

2 Choose the parameter label you want to change from the Label pop-up menu.

The current choices for that parameter appear in the box. Many BDIS reagents are defined in the default reagent list.

3 To add a reagent name or parameter label to the list, click New.

Enter the reagent name in the dialog box that appears and click OK.
To delete a reagent name or parameter label from the list, click the reagent name, and click Delete.

4 Click OK on the Edit Reagent List dialog box.

**Edit Panels**

The Edit Panels dialog box contains a list of the panels, a list of the tubes in a selected panel, and a list of the parameter labels for a selected tube. To view the tubes for a panel, click the icon to the left of the panel name. Click the icon to the left of a tube to see the parameter labels. The Tube and Labels lists are empty if no panel is selected or if more than one panel is selected in the Panels list. Similarly, the Labels list is empty if no tube is selected or more than one tube is selected in the Tubes list.

**To add a new panel:**

1 Choose Edit Panels from the Acquire menu.

The Edit Panels dialog box appears.

An IMK-Lymph panel is defined in the default panel list.
Chapter 3: Preparing for Acquisition

2 Click Add above the Panels list.

The new panel will be added to the bottom of the list with the default name *new panel*.

3 Enter a name for the panel (up to 32 characters).

**To add a new tube to a panel:**

1 Select the panel and click the Add button above the tube list.

The new tube is added to the bottom of the tube list.

2 Enter a name for the tube (up to 32 characters).

3 Select labels for the parameters.

Use the pop-up menus in the Labels list or type in each field.

**To change a panel or tube name or a parameter label:**

1 Click on the panel or tube name or parameter label.

2 Enter the new name (up to 32 characters).

Alternately, you can change a parameter label by choosing a new label from the pop-up menu to the right of the label.

**To reorder panels or tubes:**

1 Select one or more panels or tubes in the list.

2 Drag them to a new location.

A small arrow in the space to the left of the reordering icons guides you. Sort panels into alphabetical order by clicking Sort above the Panels list.
To duplicate a panel or tube:

1. Select a panel or a tube.

2. Click Duplicate above the Panels list or Tubes list.

   NOTE: To copy a panel from one computer to another, simply save an Experiment document with the panel defined. Open the document on the other computer. The panel is automatically added to the panel list. To copy all panels to another computer, copy the CellQuest Prefs file in the System folder into the System folder on the other computer.

To delete panels or tubes:

1. Select one or more panels or tubes.

2. Click Delete above the panel or tube list.

To use a panel for acquisition:

1. Click the Panel check box in the Parameter Description window.

   The Panel and Tube pop-up menus are enabled.

2. Choose the desired panel in the Panel pop-up menu.

   The parameter labels for the first tube are filled in. You cannot edit the parameter labels at this point because the panel is defined.

3. Acquire the sample.

   When acquisition of the first tube is complete, the file name, the Tube pop-up menu, and the parameter labels automatically increment to the next tube. The file name in the Acquisition Control window is also incremented.
Chapter 3: Preparing for Acquisition

If you choose Tube Number in the File Name Suffix pop-up menu, the tube number is appended to the file name. After acquiring all the tubes in the panel for the first patient, the Tube Number returns to 001 for the next patient.

Quantitative Calibration

The Quantitative Calibration command on the Acquire menu enables conversion of FL2 fluorescence intensity into phycoerythrin (PE) molecules. CellQuest calculates the regression line relating PE/bead to FL2-H. The slope and intercept information is saved in the subsequent data files for an assay. See Chapter 10, Quantitative Calibration.

Connect to Cytometer

Use the Connect to Cytometer command on the Acquire menu to access the controls on the Cytometer menu.

3.3 Using the Cytometer Menu Commands

The Cytometer menu allows you to access cytometer controls, display cytometer status, and save and restore instrument settings.

<table>
<thead>
<tr>
<th>Cytometer</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Detectors/Amps</td>
<td>1</td>
</tr>
<tr>
<td>Threshold</td>
<td>2</td>
</tr>
<tr>
<td>Compensation</td>
<td>3</td>
</tr>
<tr>
<td>Status</td>
<td>4</td>
</tr>
<tr>
<td>Instrument Settings...</td>
<td></td>
</tr>
<tr>
<td>Sort Counters</td>
<td></td>
</tr>
</tbody>
</table>

To enable the Cytometer menu, you must first choose Connect to Cytometer from the Acquire menu. Choosing the first three Cytometer menu items displays

* US Patent No. 4,520,110; European Patent No. 76,695; Canadian Patent No. 1,179,942.
windows used to alter the cytometer settings. Make all changes by using the incrementor/pop-up slider controls.

There are three ways to change settings using these controls:

1. Click the up and down arrows. The number is increased or decreased by one. Click and hold the arrows for faster adjustments.

2. Click the up and down arrows while pressing the Option key. The number is incremented or decremented by ten. Click and hold the arrows for faster adjustments.

3. Click the icon between the up and the down arrows to display a slider. Drag the slider up or down. The new value appears in the settings box. After releasing the mouse button, the slider disappears.

NOTE: The Detectors/Amps, Threshold, and Compensation windows can vary by instrument.

**Detectors/Amps**

Use this option to change PMT detector voltages and amplifier gains.

1. Choose Detectors/Amps.

   The Detectors/Amps window appears (Figure 3-4) with the name of each parameter and the current PMT settings.

   This window has up to three different sizes, depending on cytometer configuration. To resize the window, click the zoom box.

2. Choose either Lin or Log from the Mode pop-up menu.

3. Choose a DDM parameter if desired.
4 Adjust PMT voltages or Amp gains.

![Detectors/Amps window, three sizes](image)

**Figure 3-4** Detectors/Amps window, three sizes

**Threshold**

Use the Threshold command to change the threshold parameter or value.

1 Choose Threshold.

The Threshold window appears (Figure 3-5). Click the zoom box to display the 3- or 4-color view of the window.

2 Click a radio button to choose a threshold parameter.

The corresponding value column is enabled.
3 Adjust the threshold value.

![Threshold window, 3- and 4-color views](image)

**Figure 3-5** Threshold window, 3- and 4-color views

**Compensation**

1 Choose Compensation from the Cytometer menu.

The Compensation window appears. This window has three different sizes. To resize the window, click the zoom box.

![Compensation window](image)

2 Adjust the compensation value.
Chapter 3: Preparing for Acquisition

Instrument Settings

Instrument settings are saved automatically in the text section of FCS files. They can also be saved in a separate instrument settings file. The Instrument Settings dialog box displays a summary of the current settings. From this window, the settings can be printed or saved and restored.

To save instrument settings:

1. Choose Instrument Settings from the Cytometer menu.
   
   The Instrument Settings dialog box appears.

   ![Instrument Settings Dialog Box]

   - Click Save.

   - Enter a name (up to 31 characters) in the dialog box that appears, and choose a location for the settings file.

   - Click Save.
To restore instrument settings:

2. Click Open.
   
   Locate the desired instrument settings file or FCS file from the dialog box that appears.
3. Click Open.
   
4. Click Set to send these settings to the cytometer.
   
   If you wish to return the previous settings to the instrument, click Revert.

To print instrument settings:

2. Click Print.
   
   The Print dialog box appears.
3. Select the printing options, and click Print.

Instrument Status

The instrument Status window allows you to check the current state of the cytometer. It displays test pulse status, instrument status, laser power and current, sample voltage, and sheath and waste tank status.

Test pulses are electronically generated signals. On FACScan, FACS Vantage and FACStarPLUS, turn the test pulses on and off from the cytometer's front panel.
Chapter 3: Preparing for Acquisition

On a FACSCalibur and FACSort, turn the test pulses on and off in the CellQuest Status window. Instrument status is not available via the software when using a FACS Vantage or FACStarPLUS. Status information appears on the instrument video screen.

For more information on the Status window, see the appropriate instrument manual.

1. Choose Status from the Cytometer menu.

   The Status window appears. For FACSscan this is a read-only window. For FACSCalibur or FACSort, this is also the test pulse controller.

2. Choose FSC, All, or Off from the Test Puleses pop-up menu.

   Choosing FSC generates test pulses in the forward scatter channel only; choosing All generates test pulses in all channels.

### 3.4 Sorting with FACSCalibur or FACSort

Access all sorting controls in CellQuest via the Sort Counters menu item in the Cytometer menu and the Sort Setup menu item in the Acquire menu. These menu items are only present if you have a FACSCalibur equipped with the sorting option, or a FACSort. You adjust instrument settings and set sort gates before starting the sort. For a complete discussion on sorting, refer to the appropriate instrument manual.
To set up the sort:

1. Choose Connect to Cytometer from the Acquire menu.

2. Create acquisition plots and define regions for sorting.
   You can use any gate for sorting.

3. Choose Sort Setup from the Acquire menu.
   The Sort Setup dialog box appears.

   ![Sort Setup Dialog](image)

4. Choose a Sort Gate from the pop-up menu.

5. Enter the number of cells you want to sort in the Sort Count field.
   To sort continuously, enter 0.

6. Choose a Sort Mode from the pop-up menu.
   Choose among Recovery, Exclusion, and Single Cell. For a complete discussion on sort modes, refer to the FACSCalibur or the FACSort instrument manual.

7. Choose whether or not to list aborted events, and click OK.
Chapter 3: Preparing for Acquisition

8 Choose Sort Counters from the Cytometer menu.

The Sort Counters window appears. Choose the counters to display by clicking each of the three pop-up menus.

```
<table>
<thead>
<tr>
<th>Counters</th>
<th>Threshold Rate</th>
<th>Sort Rate</th>
<th>Abort Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
```

9 Install tubes in the collection station.

To sort:

1 Install a sample on the sample injection port (SIP).

2 Click Acquire in the Acquisition Control window.

Sorting starts immediately. To stop sorting, click Pause, and then click Abort.

3.5 Using the FACS Vantage

All FACS Vantage-specific controls in CellQuest are in the Acquire and Cytometer menus (Figure 3-6). Before acquiring samples or sorting with the FACS Vantage, you must align and optimize the cytometer. Before sorting, you must adjust the frequency, amplitude, and phase of the drop drive, and calculate the drop delay. These adjustments are all performed directly on the cytometer; refer to the FACS Vantage instrument manual. Set the drop delay, deflected drops, sort mode, and direction of unsorted cells, and define plots and gates. You
can make many selections and adjustments either directly on the cytometer or via the software. However, you must use the software to set compensation.

**Figure 3-6** Acquire and Cytometer menus

**To set up CellQuest for sorting:**

1. Choose Connect to Cytometer from the Acquire menu.
2. Choose AutoSORT from the Cytometer menu.
3. Follow the steps in the FACS Vantage manual to enter values for A, B, and C in the AutoSORT dialog box that appears (Figure 3-7).
4. Click Done when you are finished.

   Click Redo if you want to change the current value.
Figure 3-7 AutoSORT dialog box

5 Choose Sort Control from the Cytometer menu.

The Sort Control window appears.

6 Choose from the available options.

Choose:
- Deflected Drops—a value from 1 to 7
- Sort Mode—Enrich, Normal-C, Counter, or Normal-R
- Unsorted Cells—Center or Right
**CellQuest Software Reference Manual**

For an explanation of sort modes, refer to the FACS Vantage manual.

7 Install your sample and collection tubes on the FACS Vantage.

8 Create acquisition plots and define regions for sorting.

See Chapter 9, Regions and Gates, for information on defining regions. You can also set sort regions manually by choosing Manual Sort Windows from the Cytometer menu and using the sliders to numerically define a sort gate.

9 Choose Sort Region Selection from the Acquire menu.

The Sort Region Selection dialog box appears. Only rectangular and histogram regions can be used for sorting; therefore, only these types of regions appear in this dialog box.

<table>
<thead>
<tr>
<th>Sort Region Selection</th>
<th>Px</th>
<th>Py</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left Right Label</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0 □ R2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>0 □ R5</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>0 □ R4</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>0 □ R3</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>0 □ R6</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>0 □ R7</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>0 □ R1</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>0 □ R9</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>0 □ R3</td>
<td>4</td>
<td>3</td>
</tr>
</tbody>
</table>

10 Select left and right sort regions, and click Load.

Sorting starts as soon as Load is clicked. You can monitor the sort with the counters on the FACS Vantage. To stop sorting, open the stream door or
clear check boxes on the Sort Region Selection or Manual Sort Windows and click Load again.

**FACS Vantage–Specific Instrument Control Windows**

The instrument control windows for FACS Vantage are different from those for FACSscan and FACSsort and vary depending on which options are installed on your cytometer.

1. Choose Detectors/Amps, Threshold, and Compensation from the Cytometer menu.

These instrument control windows appear.

2. If your FACS Vantage is equipped with Pulse Processing options, choose Pulse Processing Parameters from the Cytometer menu.
A window appears that allows you to configure these options. Selections in this window affect selections available in the Detectors/Amps window.

NOTE: You must configure the Pulse Processing Parameters window for the parameters you plan to use before you select the parameters in the Detectors/Amps window.

3 If your FACS Vantage is equipped with a Sort Enhancement Module (SEM), choose SEM from the Acquire menu.

A dialog box appears that allows you to configure the SEM.

Refer to the *FACS Vantage Sort Enhancement Module User's Guide.*
Chapter 3: Preparing for Acquisition

3.6 Using the FACStar$PLUS$

All FACStar$PLUS$-specific controls in CellQuest are in the Acquire and Cytometer menus.

Before acquiring samples or sorting with the FACStar$PLUS$, you must align and optimize the cytometer. Before sorting, you must also adjust the frequency, amplitude, and phase of the drop drive, and calculate the drop delay. These adjustments are all performed directly on the cytometer; refer to the FACStar$PLUS$ User’s Guide. Many selections and adjustments can be made either directly on the cytometer or via the software. However, you must use the software to set the compensation.

To set up CellQuest for sorting:

1. Choose Connect to Cytometer from the Acquire menu.

2. Choose Sort Control from the Cytometer menu to access the Sort Control window.
3 Choose from the available options.

Choose:

- Droplet Delay—a value between 6.0 and 21.75
- Deflected Drops—a value from 1 to 5
- Sort Mode—Enrich, Normal-C, Counter, and Normal-R
- Unsorted Cells—Center or Right for Unsorted Cells

For an explanation of sort modes, refer to the FACStarPLUS User’s Guide.

4 Install your sample and collection tubes on the FACStarPLUS.

5 Create acquisition plots and define regions for sorting.

You can also set sort regions manually by choosing Manual Sort Windows from the Cytometer menu and using the sliders to numerically define a sort gate. CellQuest does not display manually entered sort windows on a plot.
Chapter 3: Preparing for Acquisition

6 Choose Sort Region Selection from the Acquire menu to access the Sort Region Selection dialog box.

<table>
<thead>
<tr>
<th>Sort Region Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
</tr>
<tr>
<td>R0</td>
</tr>
<tr>
<td>R1</td>
</tr>
<tr>
<td>R4</td>
</tr>
<tr>
<td>R5</td>
</tr>
<tr>
<td>R7</td>
</tr>
<tr>
<td>R1</td>
</tr>
<tr>
<td>R0</td>
</tr>
</tbody>
</table>

Only rectangular and histogram regions can be used for sorting, unless you have an SEM; therefore, only these types of regions appear in this dialog box.

7 Select left and right sort regions, and then click Load.

Sorting starts as soon as Load is clicked. You can monitor the sort with the counters on the FACStarPLUS console. To stop sorting, open the stream door or clear check boxes on the Sort Region Selection or Manual Sort Windows and click Load again.

FACStarPLUS-Specific Instrument Control Windows

The instrument control windows for FACStarPLUS are different from those for FACSscan and FACSsort and vary depending on which options are installed on your cytometer.
1 Choose Detectors/Amps, Threshold, and Compensation from the Cytometer menu.

These instrument control windows appear.

2 If your FACStarPLUS is equipped with Pulse Processing options, choose Pulse Processing Parameters from the Cytometer menu.

Use the window that appears to configure these options. Selections made in the Pulse Processing Parameters window affect selections available in the Detectors/Amps window.
Chapter 3: Preparing for Acquisition

NOTE: You must configure the Pulse Processing Parameters window for the parameters you plan to use before you select the parameters in the Detectors/Amps window.

3 If your FACStar PLUS is equipped with a Sort Enhancement Module (SEM), choose SEM from the Acquire menu.

A dialog box appears that allows you to configure the SEM.

Refer to the FACStar PLUS Sort Enhancement Module User’s Guide.

3.7 Checking Cytometer Status

To ensure initialization, always turn on the cytometer before turning on the computer. The Cytometer menu and most Acquire menu items are disabled if the:

- computer is turned on first
- cable is not connected
- acquisition card is not present
- BDPAC or BDMAC is set to None for cytometer type

The BDPAC for the PowerPC and the BDMAC for a Quadra 650 computer are computer boards that allow the computer to communicate with the cytometer. During installation, your Becton Dickinson Field Service Representative
CellQuest Software Reference Manual

configures the BDPAC/BDMAC board using the BDPAC/BDMAC window to enter cytometer type and serial number. The information should be changed only if you connect your computer to another cytometer or if you upgrade your cytometer with new options.

To check the status of your cytometer:

1. Choose Control Panels from the Apple menu.
2. Double-click the BDPAC or BDMAC icon.

The BDPAC or BDMAC window appears. The current cytometer status appears, as illustrated in these examples.

If the Status indicates a condition you cannot remedy, call the Becton Dickinson Immunocytometry Systems (BDIS) Customer Support Center at (800) 448-BDIS (2347) in the US. Customers outside the US contact your local Becton Dickinson Service Representative or distributor.

3. Click the close box to remove the window.
Acquiring Data

- starting acquisition
- displaying live statistics
- using acquisition to analysis plots
- using time-dependent plots
- ending acquisition
4.1 Starting Acquisition

After you have defined acquisition plots, storage gates, file saving, parameter saving, reagents and panels, and counters, you are ready to acquire data.

BDIS recommends you turn off file sharing during acquisition.

To begin acquisition:

1. Choose Connect to Cytometer from the Acquire menu.

   The Acquisition Control window appears.

   ![Acquisition Control Window]

   Notice that the Setup check box is checked. This allows you to acquire in Setup mode. No data is saved in Setup mode, and the File name field is blank.

2. Install your sample on the Sample Injection Port (SIP).

3. Click Acquire.

   This puts the software in Setup mode which allows you to view your samples and make instrument adjustments before saving the events to a file. Counters are activated, but termination counts are not in effect. Pause replaces Acquire in the Acquisition Control window.

4. Make any necessary adjustments to the instrument settings.

5. Click Pause, and then Abort.
Chapter 4: Acquiring Data

6 Click the Setup check box to uncheck it and exit Setup mode.

The File Name entered in the Parameter Description window appears, indicating the next acquisition will save events to a file.

![Acquisition Control Window]

File: PowerPC BD Applications...\LIQuest Folder: Data 001
[Setup  Acquire  Restart  Save  Abort]

file name and folder location

In this view of the Acquisition Control window, the destination folder and the data file name are combined on one line. If the text is too long to fit on one line, the middle of the text is removed and replaced with ellipses (...).

7 Click Acquire.

Acquisition to the file begins.

8 To pause acquisition, click Pause.

Resume replaces Pause in the Acquisition Control window.

Acquisition can only occur in one Experiment document at a time. If you pause acquisition, you cannot open or create another Experiment document until you save or abort acquisition. Also, any additional open documents are hidden; only the active acquisition document is shown.

Click any of the following:

- Resume—to continue collecting events, adding events to those already acquired.
- Restart—to begin collecting events, discarding the events already acquired.
- Save—to stop collecting events, saving the events already acquired to the data file.
- Abort—to stop collecting events, discarding the events already acquired.
The system beep sounds at the completion of acquisition. If acquiring panels, CellQuest automatically updates the parameter labels for the next tube and increments the file name suffix. If panels are not being used, only the file count is incremented.

### 4.2 Displaying Live Statistics

CellQuest can display region, histogram, and quadrant statistics while acquiring data. First you must create the regions or markers; then you can display the statistics. Live statistics can be displayed as last second or cumulative. See Chapter 6, 2D Statistics, and see Chapter 8, Histogram Statistics.

1. Select the acquisition plot or the acquisition to analysis plot with its markers or regions defined.

2. Choose the appropriate item from the Stats menu.

```
Stats
Histogram Stats
K-S Stats...
Region Stats
Gate Stats
Quadrant Stats
Edit...
```

The corresponding statistics view appears (Figure 4-1).
Chapter 4: Acquiring Data

NOTE: Undefined values are represented by *** in a statistics view.

**Figure 4-1** Histogram Statistics (top), Quadrant Statistics (center), and Region Statistics (bottom) views
4.3 Using Acquisition to Analysis Plots

Use CellQuest to define acquisition plots, analysis plots, and acquisition to analysis plots. An acquisition to analysis plot is one that automatically changes from an acquisition plot to an analysis plot when data acquisition is complete. The data from the file just acquired appears in the plot, with any markers and gates set during acquisition. Any live statistics views update to reflect all the events acquired. The analysis plot reverts back to an acquisition plot when you click Acquire.

Parameter Numbering System

To work successfully with acquisition to analysis plots, it is important to understand CellQuest’s parameter numbering system. The parameters used in a plot are defined by number rather than by name.

Acquisition to analysis plots can use all the parameters that a cytometer is sending out as well as the time parameter. Each parameter has a number associated with it. If a subset of a cytometer’s parameters is saved to a data file, the parameter numbering changes. This can affect the parameters displayed by the plots.

Consider the following example for a FACSCalibur cytometer.

1. In the Parameters Saved dialog box choose to save P1: FSC-H, P3: FL1-H, and P5: FL3-H to a data file. See Figure 4-2. On the cytometer, these parameters are listed as P1, P3, and P5. When they are saved to a data file they will be listed as P1, P2, and P3 so no gaps will occur in the numbering.

2. Create an acquisition to analysis dot plot of P1: FSC-H vs P2: SSC-H.
3 Create an acquisition to analysis dot plot of P3: FL1-H vs P5: FL3-H.

![Parameters Saved dialog box](image)

**Figure 4-2** Parameters Saved dialog box

When the P1 vs P2 dot plot changes to an analysis plot upon completion of acquisition, it updates using parameters 1 and 2 from the data file. Parameter 2 for the data file (FL1-H) is not the same as parameter 2 for the cytometer (SSC-H).

Since there is no fifth parameter in the data file for this example, the P3 vs P5 dot plot must use parameter numbers that are in range. If one or both parameters of a dot plot (or density plot) are out of range, the plot changes its parameter numbers to P1 and P2. The parameter for a histogram plot changes to P1.

In this example, therefore, the P3 vs P5 dot plot becomes a P1 vs P2 plot and shows FSC-H vs FL1-H for the data file.

The following table illustrates how parameter numbering differs between the cytometer and the data file for this example.
4.4 Using Time-Dependent Plots

All acquisition plots are time dependent since events are displayed as they come from the cytometer. For kinetic experiments, you can introduce time as a parameter in any acquisition plot.

NOTE: The time parameter in the Parameters Saved dialog box is not enabled until you choose Event Count or Time in the Collection Criteria field of the Acquisition & Storage dialog box.

A dot plot with a time parameter shows events acquired over time. You set the time interval for acquisition. The dot plot shows dots moving left to right, assuming time is the X parameter.

A density plot with a time parameter is similar to a dot plot with a time parameter, with the addition of two features:

1. The density plot keeps a history of the acquisition. It adds events to the latest time interval while keeping the information from previous time intervals.

<table>
<thead>
<tr>
<th>Cytometer (Live Data)</th>
<th>Data File (Saved Data)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter Number</td>
<td>Parameter Name</td>
</tr>
<tr>
<td>1</td>
<td>FSC-H</td>
</tr>
<tr>
<td>2</td>
<td>SSC-H</td>
</tr>
<tr>
<td>3</td>
<td>FL1-H</td>
</tr>
<tr>
<td>4</td>
<td>FL2-H</td>
</tr>
<tr>
<td>5</td>
<td>FL3-H</td>
</tr>
<tr>
<td>6</td>
<td>FL2-A</td>
</tr>
<tr>
<td>7</td>
<td>FL2-W</td>
</tr>
</tbody>
</table>
2. The plot colors the dots according to the number of events at a particular channel location.

A histogram with a time parameter becomes a bar plot showing data acquired during each time interval. It maintains a history of all events acquired throughout the acquisition, assuming you have chosen to show all events. See Chapter 3, Preparing for Acquisition.

### 4.5 Ending Acquisition

There are three ways to end data acquisition:

1. manually—Click Pause; then click Abort or Save.
2. by count—Set an event count in the Acquisition & Storage dialog box.
3. by time—Set a time limit in the Acquisition & Storage dialog box.

CellQuest ends acquisition when the first of these conditions is met. You must either quit CellQuest or choose Disconnect from Cytometer from the Acquire menu to use a different acquisition software. When you disconnect from the cytometer, all instrument control windows automatically close and the Cytometer menu is disabled.

The appearance of data in acquisition plots or statistics views will not be affected when you:

- move or resize a plot or statistics view
- print an Experiment document
- scroll an Experiment document
- save an Experiment document

NOTE: When you open a saved Experiment document, acquisition plots and their associated statistics views are cleared.
5

CellQuest Plots

- CellQuest plot types
- creating CellQuest plots
- choosing formatting options for each plot
- reformatting a dot plot, contour plot, density plot, or 3D plot
- displaying the Next/Previous files
- adding text to an Experiment document
- zooming plots
5.1 CellQuest Plots

CellQuest lets you create and format various types of plots. Use dot plots and density plots for acquisition or analysis and contour and 3D plots for analysis only. After you create a plot, you can add annotations and CellQuest will redraw the plot, updating it with associated statistics and annotations. For a discussion of histogram plots, see Chapter 7, Histograms.

Dot Plot

A dot plot provides a two-parameter display of data. Each dot in a dot plot represents one or more events (cells or particles). The dot location is defined by two values, one for each parameter.

![Dot Plot](image)

**Figure 5-1** Dot Plot

Contour Plot

Like a dot plot, a contour plot (Figure 5-2) provides a two-parameter display of data. Each event has a position in the plot according to its channel values for both parameters. Contour lines in the plot provide a third dimension by joining
x and y coordinates with similar event counts. These plots are similar to topographic maps which use contour lines to show points at the same elevation.

**Figure 5-2** Contour plot

**Density Plot**

A density plot simulates a three-dimensional display of events. It is similar to a dot plot except it uses colors to show the number of events. As CellQuest acquires more events, the number of events change and the colors in the density plot change. The position of each event on the x- and y-axis reflects its parameter values. The color shows the number of events at each x and y position on the plot.

**Figure 5-3** Density plot
3D Plot

Like a contour plot, a 3D plot provides a two-parameter display of data. The same data displayed in a contour plot can be shown from a different perspective in a 3D plot. Figure 5-4 shows the same file displayed as a contour plot and as a 3D plot.

Figure 5-4  Contour plot (left), 3D plot (right)
5.2 Creating CellQuest Plots

Use the commands in the Plots menu or use the appropriate tool from the tool palette to create a dot plot, a contour plot, a density plot, or a 3D plot. See Chapter 7, Histograms, for instructions on creating a histogram.

![Plots menu and Plot tools](image)

**Figure 5-5** Plots menu and Plot tools

Some menu commands are common to all plots while others are valid only for specific plots. You cannot set markers or regions on a 3D plot, for example, but you can generate region and gate statistics.

**To create a dot plot, contour plot, density plot, or 3D plot:**

1. Choose the appropriate item from the Plots menu.

   The corresponding plot dialog box appears (Figure 5-6).

   Alternately, you can specify the size and location of a plot by selecting the appropriate tool from the tool palette. Using the plot tool:
   - Click in an unused section of the Experiment document.
   - Drag diagonally until the plot outline is the desired size.
The corresponding plot dialog box appears, allowing you to select plot options.

![Dot Plot Dialog Box]

**Figure 5-6** Example of a plot dialog box

2 Click Select File in the plot dialog box.

Use the Open a Data File dialog box that appears to select a file for analysis.

![Open a Data File Dialog Box]

3 Click Open.

The plot dialog box reappears.

4 Choose the X and Y parameters from the Parameter pop-up menus.

5 Choose a gate from the Gate pop-up menu, if desired.
5.3 Formatting CellQuest Plots

Use the Dot Plot dialog box to format a dot plot.

1. Choose to display a percent of dots from the pop-up menu under Options.

   Displaying 50% of dots for a 2,000-event file will display every other event and not the first 1,000 events. When analyzing large data files, it is sometimes desirable to display only a portion of the events. Statistics are always calculated on all events in the file regardless of the display.

2. Choose the plot color.

   Click:
   - Single—to display all dots in one color.
   - the color box—to change the color. The Select Dot Color dialog box appears. Click the new color.
   - Multicolor Gating—to display dots in different colors. See Section 9.9, Using Multicolor Gates for Dot Plots.
3 Click OK.

The dot plot appears in the Experiment document.

Use the Contour Plot dialog box to format a contour plot.

1 Choose Scale.

CellQuest has three methods of calculating contour lines: linear density, logarithmic density, and probability. The data used by contour plots has a resolution of 64 x 64 channels. The data from adjacent channels is added to condense higher resolution data into 64 channels. Statistics calculated on a contour plot use data in the original resolution, either 256 or 1024.

Click:

- Linear Density, and type a % value. The contour lines are calculated as a percentage of the maximum event number (the peak height) and have equal spacing between them. The starting value (the outermost contour) will be half the value you requested.

Example: Enter 20% linear density.
Chapter 5: CellQuest Plots

The outermost contour represents 10% of the peak height, the next contour represents 30%, then 50%, 70%, and 90%. Equal spacing tends to put most of the contour lines on the higher peaks (representing larger numbers of events) and may not show lower features.

• Log Density, and type a % value. The contour lines are calculated as a percentage of the maximum event number and have logarithmic spacing between them. Log-density contours begin at the percentage of peak height you entered and continue until they have reached a threshold value or 1.

Example: Enter 50% log density.

The innermost contour represents 50% of the peak height, the next contour represents 50% of the first contour (or 25% of peak height), and so on. The corresponding percentages based on peak height are 50%, 25%, 12%, 6%, 3%, and 1%. This method shows more detail in the lower regions, while still showing high peaks.

• Probability, and type a % value. The contour lines are drawn as a percentage of the total event number. The contour lines are not based on maximum number of events. Instead, the area between each pair of contour lines contains an equal percentage of the total events. The starting value (the outermost contour) is half the value you entered.

Example: Enter 20% probability.

The outermost contour represents 10% of the total number of events, the next contour represents 30%, then 50%, 70%, and 90%.

2 Choose Colors.

Click:

• Single—to display all contours in the same color.
• the color box—to change this color. Click the new color on the Color Selection dialog box.
• Multi—to display the contour lines in different colors. The first, innermost contour line is drawn with the second color in the color palette, the second line with the third color, and so on.

3 Choose a value for Smoothing under Modify Data.

Type a value from 0 (no smoothing) to 5 (maximum smoothing) in the highlighted field to decrease irregularities in the contour plot profile. Smoothing does not affect calculated statistics on contour plots.

4 Choose a value for Threshold under Modify Data

Type a value from 0% (no threshold) to 100% (maximum threshold). This percentage determines the threshold level for the outermost (lowest) contour line. A threshold provides a level of discrimination to eliminate unwanted data and is a percentage of the peak. Data below this threshold is not shown. Thresholding does not affect statistics.

5 Click OK.

Use the Density Plot dialog box to format a density plot.
Choose Scale.

CellQuest has three methods of calculating density levels: linear density, logarithmic density, and probability. The data used by density plots has a resolution of 128 x 128 channels. The data from adjacent channels is added to condense higher resolution data into 128 channels.

Click:

- Linear Density, and type a % value. The density levels are calculated as a percentage of the maximum event number (the peak height) and have equal spacing between them. The starting value (the lowest level) will be half the value you requested.

Example: Enter 20% linear density.

The lowest level represents 10% of the peak height, the next level represents 30%, then 50%, 70%, and 90%. Equal spacing tends to put most of the density levels on the higher peaks (representing larger numbers of events) and may not show lower features.

- Log Density, and type a % value. The density levels are calculated as a percentage of the maximum event number and have logarithmic spacing between them. Log-density levels begin at the percentage of peak height you entered and continue until they have reached a threshold value or 1.

Example: Enter 50% log density.

The highest level represents 50% of the peak height, the next level represents 50% of the first level (or 25% of peak height), and so on. The corresponding percentages based on peak height are 50%, 25%, 12%, 6%, 3%, and 1%. This method shows more detail in the lower regions, while still showing high peaks.

- Probability, and type a % value. The density levels are calculated as a percentage of the total event number. The density levels are not based on the maximum number of events. Instead, the number of events between
CellQuest Software Reference Manual

each level is the same. The starting value (the outermost color) is half the value you entered.

Example: Enter 20% probability.

The lowest level represents 10% of the total number of events, the next level represents 30%, then 50%, 70%, and 90%.

2 Choose Colors.

Click:

• Single—to display all levels in different shades of the same color. The color gets lighter at higher levels.

• the color box—to change this color. Click the new color on the Color Selection dialog box.

• Multi—to display the density levels in different colors. The first density level is drawn with the second color in the color palette, the second level with the third color, and so forth.

3 Choose a value for Smoothing under Modify Data.

Type a value from 0 (no smoothing) to 5 (maximum smoothing) in the highlighted field to decrease irregularities in the density plot profile. Smoothing does not affect calculated statistics on density plots.

4 Choose a value for Threshold under Modify Data.

Type a value from 0% (no threshold) to 100% (maximum threshold). This percentage determines the threshold level for the outermost (lowest) density level. A threshold provides a level of discrimination to eliminate unwanted data and is a percentage of the peak. Data below this threshold is not shown. Thresholding does not affect statistics.

5 Click OK.
Chapter 5: CellQuest Plots

Use the 3D Plot dialog box to format a 3D plot.

1 Choose 3D View Angles.

Click:
- the Tilt field. Type a number between 0 and 90 degrees to change the tilt angle of the plot.
- the Rotation field. Type a number between –360 and +360 degrees to change the rotation angle. The plot rotates around an imaginary axis at right angles to, and through the center of, the 3D plot grid.

The default rotation is 315°; to rotate to the left, enter a number greater than 315°; to rotate to the right, enter a number less than 315°.

2 Choose Color.

Click:
- the Line color box. The Color Selection dialog box appears. Click on the color you want and click OK.
- the Line color box to change this color. Click the new color on the Color Selection dialog box.
Choose a value for Smoothing under Modify Data.

Type a value from 0 (no smoothing) to 5 (maximum smoothing) in the highlighted field to decrease irregularities in the 3D plot profile. Smoothing does not affect calculated statistics on 3D plots.

Choose a value for Threshold under Modify Data.

Type a value from 0% (no threshold) to 100% (maximum threshold). A threshold provides a level of discrimination to eliminate unwanted data and is a percentage of the peak. Data below this threshold is not shown. Thresholding does not affect statistics.

Click OK.

Reformatting CellQuest Plots

Use the Format command in the Plots menu to reformat a particular plot.

NOTE: To change the data files for all selected plots at once, use the Change Data File command in the Plots menu. See Section 5.5, Changing Data Files.

Select the plot you want to format.

Only one plot at a time can be changed. If multiple plots are selected, the Format command is not available.

Choose the corresponding Format item in the Plots menu.

If you select a density plot to reformat, the Format command in the Plots menu changes to Format Density Plot.

Use the plot dialog box that appears to change any options.
Chapter 5: CellQuest Plots

3 Click OK.

The Experiment document displays the reformatted plot.

You can dissociate the data file from the plot by choosing No File in the File pop-up menu. This creates a generic analysis plot, which can be used in creating templates. See Section 2.6, Using Experiment Documents as Templates.

NOTE: You can change parameters directly on the plot itself by placing the cursor over each plot axis and clicking the mouse button to open a pop-up menu listing the parameters. See Section 3.1, Creating an Acquisition Plot.

Deleting or Copying a Plot

To delete a plot:

1 Click its frame to select it.

Selection handles appear on the four corners of the plot. Only a selected plot (with handles) can be deleted.

2 Choose Cut or Clear from the Edit menu or press Delete.

The plot and any associated views, for example, statistics and annotations, are removed. You can undo the deletion of a plot by choosing Undo from the Edit menu.
To copy a plot:

1. Click the frame to select the plot.
   Handles appear on the frame.

2. Choose Copy from the Edit menu.
   The plot is copied to the Clipboard as a PICT. Black and white are reversed when plots are copied to the Clipboard.

3. Paste the plot into a third-party application.
   Plots cannot be pasted back into CellQuest documents.

Figure 5-7 Plot as it appears on screen (left) and on the Clipboard (right)
5.4 Changing the Axes of a Plot

CellQuest offers two options for displaying log-amplified data. The plot axes can be displayed in:

- log decades of linear values, for example, 1 to 10,000
- channel values, for example, 0 to 255 or 0 to 1023

The selection affects all plots in the active Experiment document. It also affects how statistics are calculated. See Section 8.1, Log Data Units.

Choose Log Data Units from the Plots menu, and click Channel Values or Linear Values from the dialog box that appears.

Click OK to remove the dialog box.

5.5 Changing Data Files

There are four ways to change the data files displayed in analysis plots:

1. Select a single plot, choose Format Plot from the Plots menu, click Select File, and select another file.
CellQuest Software Reference Manual

2. Select multiple plots, choose Change Data File from the Plots menu, and select another file.

3. Select multiple plots, and choose Next or Previous Data File from the Plots menu.

4. Choose Run from the Batch menu.

Using the Change Data File command gives you the convenience of updating several plots at once and the flexibility to access files in different folders.

1 Select one or more analysis plots.

2 Choose Change Data File from the Plots menu.

The Open a Data File dialog box appears.

3 Select a new data file, and click OK.

5.6 Displaying the Next or Previous Data File

The Next Data File and Previous Data File commands in the Plots menu allow you to select one or more analysis plots and increment or decrement their data files by any number. Next data file is defined as the next file of the appropriate type in alphanumerical order within the same folder as the original file. The new data replaces the original data. Any associated views, such as statistics and annotations, are also updated. The annotations are updated with the appropriate information. For example, if the original annotation was the patient ID, the new annotation is the patient ID from the new file.

The Next Data File command is equivalent to choosing the Format command for each plot, clicking the Select File button, and choosing the file \( n \) positions down from the original file in the list, where \( n \) is the file increment.
Chapter 5: CellQuest Plots

NOTE: The Next Data File, Previous Data File, and Change Data File commands are not available for overlaid histograms.

The following rules govern the function of the Next Data File and Previous Data File commands.

- The file increment is set by choosing File Increment from the Plots menu. Any number from 1 to 100 can be entered in the dialog box.

- Next and previous refer only to files in the same folder as the current file. For example, if your file resides in Folder A, you can only get a next or previous file from Folder A. However, you can select more than one plot and choose Next or Previous. Each of these plots can use data files located in different folders. You can increment data file A from Folder A and data file B from Folder B at the same time using the Next data file command.

- Only files of the appropriate type are considered in the increment. Non-FCS files are not considered. If the current plot is a dot plot, a single-parameter histogram file is not counted in the increment. Folders within folders are not considered. This is consistent with manually changing the data file; only those files appropriate to the specific plot type appear in the Open a Data File dialog box after clicking Select File.

- Next Data File and Previous Data File are all-or-nothing functions. If, for some reason, the data file of one plot cannot be incremented, none of the plots will be incremented. If you reach the end of the list of files in a folder, a message appears, and the first plot that could not be incremented is selected.

- If the next data file does not contain enough parameters, a message appears. CellQuest matches on parameter numbers, not parameter names, in FCS files. A given plot, for example, will remember that its x-axis is showing parameter 2 and its y-axis is showing parameter 5. No error occurs if subsequent data files have at least as many parameters as the highest numbered parameter being displayed.

An example illustrates some of these points. There are two analysis plots in an Experiment document: histogram DATA001 is located in the Data Files folder and dot plot NORM001 is located in the Sample Files folder.
Applying the Next File command to the files in the Data Files folder (Figure 5-8) is straightforward.

![Figure 5-8 Data Files folder contents](image)

- Set the file increment to 1, and the next file displayed is DATA002.
- Set the increment to 2, and the next file displayed is DATA003, and so on.

All of the files in this folder are appropriate for histograms, so the next file is easy to identify.

Applying the Next File command to the files in the Sample Files folder is more complex. Remember that only files are considered in the increment; folders within folders are disregarded. Figure 5-9 shows the contents of the Sample Files folder from the Finder.

![Figure 5-9 Sample Files folder contents shown from the Finder](image)
Chapter 5: CellQuest Plots

Figure 5-10 shows the contents of the Sample Files folder when you click Select File in the Format Dot Plot dialog box.

Figure 5-11 shows the contents of the folder when you choose Select File in the Format Histogram Plot dialog box.

- Histogram File, a single-parameter file, is displayed only when Histogram Plot is chosen.
- A dot plot cannot be generated from a histogram file, so Histogram File is not listed when Dot Plot is chosen.

With this information in mind, you see that selecting dot plot NORM001 and choosing Next File with the file increment set to 1 displays NORM002. If you again choose Next File, Old Folder is ignored. Therefore, the next file displayed
is TEST1. The Previous File command works in the same way, only moving up, rather than down, the list of files.

**To access the file before or after the current file:**

1. Choose File Increment from the Plots menu.

   The File Increment dialog box appears.

2. Type an increment value, and click OK.

3. Select one or more plots in the Experiment document.

4. Choose Next Data File or Previous Data File from the Plots menu to change the data file for each selected plot.

   The plot, along with its associated statistics and annotations, is redrawn with the same parameters. *Next* is defined as the FCS file located in the folder of the current file that follows the current file in an alphanumeric list, while *Previous* means the file that precedes the current file in an alphanumeric list.
5.7 Batch Menu

The Batch menu provides batch analysis capability based on the Next Data File command in the Plots menu.

When you select plots in an active Experiment document, batch analysis calls the Next Data File command repeatedly until the plots can no longer advance to the next file in their folders. In addition, the batch analysis provides the following features:

- automatic pausing of a batch analysis after each execution of the Next Data File command. Choose to resume batch analysis after a specified period of time, for example, from 1 to 20 seconds, or when you signal a resumption. You can adjust markers or regions while the batch is paused.
- manual pausing, resuming, or aborting a batch analysis.
- automatic printing of the document after each execution of the Next Data File command. If you choose the automatic pause option, printing occurs after the pause.
- automatic exporting of selected statistics views to a new or existing file. If you choose the automatic pause option, the export occurs after the pause.
- exporting stats to a new or existing export file.
- optional processing of all plots and statistics views in an Experiment document or only the current selection.
Setup

Use the Batch Setup dialog box to set the parameters for the batch.

1. Choose Plots and Stats to Process.
   - Click:
     - All—to select all plots in the document each time the Next Data File command is executed. Choose this option to process all plots in the active document.
     - Currently Selected—and the current selection in the Experiment document will not change before calling the Next File command. Use this option if you want to select some plots to advance to the next file but not others.

2. Choose Pause after each file increment.
   - You can make changes to regions and markers during a pause.
   - Click:
     - None—to process the selected plots and stats without pausing.
     - until manual resume—to pause a batch after each Next Data File command. Resume by clicking Resume in the Batch Control floater.
Chapter 5: CellQuest Plots

- for \( n \) seconds—to pause for 1 to 20 seconds after each Next Data File command. End the timed pause early by clicking Resume in the Batch Control floater.

3 Choose Print, after each file increment.

Click the checkbox if you want the Print One command (File menu) executed after each Next File command. If you chose a pause option, printing occurs after the pause.

4 Choose to export statistics.

Click the Export statistics checkbox to export statistics after each Next Data File command. If you chose a pause option, exporting occurs after the pause.

Click:
- New File—to create a new statistics export file.
- Existing File—to choose an existing file to append statistics to.

Export File displays the current statistics export file and its path.

5 Enter a File Increment for the Next Data File command.

This is the same value entered in the File Increment dialog box in the Plots menu. See Section 5.6, Displaying the Next or Previous Data File.

6 Click OK.

All the settings selected in the Batch Setup dialog box are saved in the CellQuest Experiment document.
**CellQuest Software Reference Manual**

**Run**

Choose the Run command to start the batch analysis, using the parameters set in the Setup dialog box.

A Batch Control floater appears.

![Stop, Pause, Resume Buttons](image)

This floater has three buttons that allow you to manually control a batch analysis. Click the:

- **left button**—to stop a batch.
- **center button**—to resume a batch during a pause. The resume button is disabled if a batch is not paused.
- **right button**—to pause a batch. The pause button is disabled if a batch is paused.

The Batch Control floater closes automatically when a batch finishes or when you press the stop button in the floater.

**5.8 Adding Text in an Experiment Document**

There are two ways to add text to an Experiment document. The first method, annotating, allows you to add only text that was saved in a plot data file. The second method, adding free text, allows you to add any text you type or paste. Both types can reside anywhere in the Experiment document.
Adding an Annotation

1. Click the plot.

2. Choose Annotation from the Plots menu and hold down the mouse button to view the pull-down menu.

A submenu with a list of annotation types appears. The available choices vary based upon which items were saved in the data file.

3. Choose the type of annotation you want from this list.

The annotation, drawn from the current data file, appears. When the annotation is selected, handles appear around it.

- To move the annotation to a different location, click and drag it.
CellQuest Software Reference Manual

- To change the width of the annotation, click the annotation, and drag a handle in or out.

You can change the text style of a selected annotation with the Text Settings command in the Edit menu, but you cannot edit the annotation text. To delete the annotation, select it, and choose Cut or Clear from the Edit menu or press Delete. An annotation is associated with its plot; if a plot is deleted, its annotation is also deleted.

Adding Free Text

1. Select the Text tool from the tool palette.

2. Click to position the insertion point.

   You can place free text anywhere in the Experiment document. A blinking vertical bar appears at the insertion point.

3. Type your comments.

   The text wraps around after reaching a default width. Click anywhere to complete the entry.

   Handles appear around selected free text.

   ![Handles around free text](image)
• To move free text to a different location, click and drag it.
• To change the width of free text, click the free text, and drag a handle in or out.
• To delete free text, select it, and choose Cut or Clear from the Edit menu. or press Delete.

You can edit the text itself with the Text tool or the text style with the Text Settings command in the Edit menu. Select the Text tool and position the cursor where you want to edit the text. Choose Text Settings to change the color, style, font, or size of the text. See Section 2.3, Edit Menu.

5.9 Zooming a Plot

To magnify an interval of a histogram:

1 Select the Zoom-In tool from the tool palette.

2 Click in a histogram plot to set the left edge of the interval to be magnified, and drag to set the right edge.

As the cursor passes over a plot, its shape changes to a crosshair to indicate that you can zoom. The coordinates of the zoomed area appear in the ribbon of the Experiment window. To further zoom the plot, repeat step 2.
To magnify an interval of a dot, density, or contour plot:

1. Select the Zoom-In tool from the tool palette.

2. Click in a dot, density, or contour plot to set the upper-left point of the interval to be magnified, and drag diagonally to set the lower-right point.

   As the cursor passes over a plot, its shape changes to a crosshair to indicate that you can zoom. The coordinates of the zoomed area appear in the ribbon of the Experiment window. To further zoom the plot, repeat step 2.

3. To restore the plot, select the Zoom-Out tool, and click the plot once.

   NOTE: You cannot zoom an overlaid histogram in 3D view or a 3D plot.
6

2D Statistics

- creating, changing, deleting, and copying quadrant markers
- quadrant statistics
- region statistics
- gate statistics
To generate statistics for a dot plot, contour plot, or density plot, you must first define quadrants or regions. For information on defining regions and gates, see Chapter 9.

6.1 Quadrant Markers

A quadrant marker divides a 2D plot into four sections (quadrants) for calculating statistics. A plot can have only one quadrant marker. If you change the parameters of the plot, the quadrant marker and statistics are removed.

![Figure 6-1 Selected quadrant marker (left), deselected quadrant marker (right)](image)

Creating a Quadrant Marker

1. Select the Quadrant Marker tool from the tool palette.
Chapter 6: 2D Statistics

2 Click in the plot and drag to position the intersection of the quadrant markers.

As the cursor passes over the plot, its shape changes to a crosshair to indicate that you can define quadrant markers. The ribbon under the title bar displays the x and y location of the cursor as you draw the markers.

3 Release the mouse button to complete the marker.

The quadrant marker appears with a handle at the intersection.

To move a quadrant marker to a new position, click the intersection and drag it to a new location. The quadrant statistics are updated.

Deleting a Quadrant Marker

1 Select the quadrant marker you want to delete.

2 Choose Cut or Clear from the Edit menu, or press Delete.

If quadrant statistics are displayed, they are also deleted.

Copying a Quadrant Marker

1 Select the quadrant marker.

2 Choose Copy from the Edit menu.

3 Click the plot where you want to paste the marker.

4 Choose Paste from the Edit menu.

The new marker appears. The two plots need not have the same axis parameters. If a quadrant marker already exists in the plot, pasting another
quadrant marker updates the existing marker to the new location and updates the associated quadrant statistics.

### 6.2 Displaying Statistics

You can display quadrant, region, and gate statistics, and you determine which statistics to display by choosing the appropriate command from the Stats menu.

<table>
<thead>
<tr>
<th>Stats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Histogram Stats</td>
</tr>
<tr>
<td>K-S Stats...</td>
</tr>
<tr>
<td>Region Stats</td>
</tr>
<tr>
<td>Gate Stats</td>
</tr>
<tr>
<td>Quadrant Stats</td>
</tr>
<tr>
<td>Edit...</td>
</tr>
</tbody>
</table>

To maintain statistical veracity, the following rules apply:

- Statistics text may not be modified in any way.
- You can cut or copy an entire statistics view, but not the individual items in the view.

To determine what information appears in each statistics view, use the Edit Stats menu item. Your selections in any Edit Statistics dialog box determine which statistics appear. Undefined values are represented by *** in the statistics views. See Section 6.3, Editing Statistics.
Chapter 6: 2D Statistics

Quadrant Statistics

To display quadrant statistics, select a plot with defined quadrants, and choose Quadrant Stats from the Stats menu. The Quadrant Statistics view that appears displays calculated statistics for each quadrant.

<table>
<thead>
<tr>
<th>Quad</th>
<th>Entities</th>
<th># Gated</th>
<th># Total</th>
<th>X Mean</th>
<th>X Gsa Mean</th>
<th>Y Mean</th>
<th>Y Gsa Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>LL</td>
<td>1</td>
<td>0.02</td>
<td>0.02</td>
<td>35.23</td>
<td>35.23</td>
<td>56.22</td>
<td>56.22</td>
</tr>
<tr>
<td>LR</td>
<td>6</td>
<td>0.10</td>
<td>0.10</td>
<td>126.00</td>
<td>545.00</td>
<td>530.24</td>
<td>536.24</td>
</tr>
<tr>
<td>UL</td>
<td>1987</td>
<td>99.76</td>
<td>99.76</td>
<td>6.00</td>
<td>463.25</td>
<td>305.05</td>
<td>2.92</td>
</tr>
<tr>
<td>UR</td>
<td>6</td>
<td>0.10</td>
<td>0.10</td>
<td>463.25</td>
<td>305.05</td>
<td>2.92</td>
<td>2.15</td>
</tr>
</tbody>
</table>

Region and Gate Statistics

You can display region statistics for two-parameter plots. Statistics are displayed for all regions in the Region List. You can generate region statistics for a plot even if the regions were drawn on another plot with different parameters.

You can display gate statistics for two-parameter plots. Statistics are calculated for all valid gates in the Gate List.
To display region or gate statistics, select a two-parameter plot, and choose Region Stats or Gate Stats from the Stats menu. The corresponding statistics view appears.

![Figure 6-2 Regional Statistics (top) and Gate Statistics (bottom) views](image)

### 6.3 Editing Statistics

You determine what information appears in the quadrant, region, and gate statistics views by using the Edit command in the Stats menu. While certain information is common to all three views, other information is specific to each.

Up to three custom keywords can be displayed in each statistics view. The default is to display none. A custom keyword with its value is displayed if you have defined it. For example, if you select Custom Keyword #1 in the Edit Statistics dialog box, but you have not defined that keyword, it will be displayed as *Custom Keyword #1:* with no value following.
1. Click the statistics view to select it and choose the Edit command from the Stats menu.

The corresponding dialog box appears.

Figure 6-3 Edit dialog boxes from Stats menu
If you selected the Quadrant Statistics view, for example, the Stats menu item reads Edit Quadrant Stats.

2 Click the checkboxes of the items you want to appear in the statistics view.

Make Header Info and Header Column choices for Quadrant, Region, and Gate Statistics views.

**Header Info**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Line</td>
<td>Labels the view Quadrant Statistics, Region Statistics, or Gate Statistics</td>
</tr>
<tr>
<td>File Name</td>
<td>Name of data file</td>
</tr>
<tr>
<td>Log Data Units</td>
<td>Units used for calculating and displaying statistics, either linear values or channel numbers</td>
</tr>
<tr>
<td>Sample ID</td>
<td>Sample identification</td>
</tr>
<tr>
<td>Patient ID</td>
<td>Patient identification</td>
</tr>
<tr>
<td>Patient Name</td>
<td>Patient name</td>
</tr>
<tr>
<td>Case Number</td>
<td>Case number</td>
</tr>
<tr>
<td>Custom Keywords</td>
<td>The first three defined custom keywords</td>
</tr>
<tr>
<td>Tube</td>
<td>Tube name</td>
</tr>
<tr>
<td>Panel</td>
<td>Panel name</td>
</tr>
<tr>
<td>Acquisition Date</td>
<td>Date file was acquired or created</td>
</tr>
<tr>
<td>Gate</td>
<td>Gate label or No Gate, depending on whether a gate was applied</td>
</tr>
<tr>
<td>Total Events</td>
<td>Total number of events in the data file</td>
</tr>
<tr>
<td>Gated Events</td>
<td>Number of events in the gate applied to the data file</td>
</tr>
<tr>
<td>Parameters</td>
<td>X and Y parameters and their data mode (linear or log)</td>
</tr>
</tbody>
</table>
Chapter 6: 2D Statistics

Smoothing Iterations (Smooths)

Always reads zero because statistics are calculated on unsmoothed data

Quad Location

The x and y coordinates at the intersection of the quadrant markers

Header Columns

Number of Columns (1 or 2)
Specify 1 or 2 header columns for an individual view; default setting is 2 Columns

Choose to display Live Stats Events for quadrant and region statistics views.

Live Stats Events

Calculation of Live Stats (Last second or Cumulative)

Calculate live stats for the last second or cumulative; disabled when selected view is in Analysis mode; default setting is Last second
Choose the Statistics to display, specific to quadrant, region, and gate statistics views.

**Statistics (Quadrant)**

<table>
<thead>
<tr>
<th>Quadrant Label (Quad)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 UL = upper-left quadrant</td>
<td></td>
</tr>
<tr>
<td>2 UR = upper-right quadrant</td>
<td></td>
</tr>
<tr>
<td>3 LL = lower-left quadrant</td>
<td></td>
</tr>
<tr>
<td>4 LR = lower-right quadrant</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Count (Events)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of events in each quadrant</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Percent of Gated (% Gated)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage of the events in a quadrant compared to the total events in the gate</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Percent of Total (% Total)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage of the events in a quadrant compared to all events in the original file</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>X Mean</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average x-axis channel number or linear value for events in the quadrant</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>X Geometric Mean (X Geo Mean)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average of the logarithm of the x-axis channel number or linear value for events in the quadrant, expressed as the anti-log</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Y Mean</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average y-axis channel number or linear value for events in the quadrant</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Y Geometric Mean (Y Geo Mean)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average of the logarithm of the y-axis channel number or linear value for events in the quadrant, expressed as the anti-log</td>
<td></td>
</tr>
</tbody>
</table>
### Statistics (Region)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region Label (Region)</td>
<td>Region label from region list</td>
</tr>
<tr>
<td>Region Parameters (Px, Py)</td>
<td>Parameters used in region (number of the parameter on the X and Y axes for each region)</td>
</tr>
<tr>
<td>Event Count (Events)</td>
<td>Number of events in each region</td>
</tr>
<tr>
<td>Percent of Gated (% Gated)</td>
<td>Percentage of the events in the region compared to the number of events in the gate</td>
</tr>
<tr>
<td>Percent of Total (% Total)</td>
<td>Percentage of the events in the region compared to the total events in the data file</td>
</tr>
<tr>
<td>X Mean</td>
<td>Average x-axis channel number or linear value for events in the region</td>
</tr>
<tr>
<td>X Geometric Mean (X Geo Mean)</td>
<td>Average of the logarithm of the x-axis channel number or linear value for events in the region, expressed as the anti-log</td>
</tr>
<tr>
<td>Y Mean</td>
<td>Average y-axis channel number or linear value for events in the region</td>
</tr>
<tr>
<td>Y Geometric Mean (Y Geo Mean)</td>
<td>Average of the logarithm of the y-axis channel number or linear value for events in the region, expressed as the anti-log</td>
</tr>
</tbody>
</table>

### Statistics (Gate)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gate Label (Gate)</td>
<td>Gate label from Gate List</td>
</tr>
<tr>
<td>Event Count (Events)</td>
<td>Number of events in each gate</td>
</tr>
<tr>
<td>Percent of Gated (% Gated)</td>
<td>Percentage of the events in the gate compared to the total events in the gate applied to the plot</td>
</tr>
<tr>
<td>Percent of Total (% Total)</td>
<td>Percentage of the events in the gate compared to all events in the data file</td>
</tr>
</tbody>
</table>
3 Click OK in the dialog box.

The statistics view does not automatically resize itself when statistics are deselected. You can resize it by dragging the selection handles. The new size is remembered when you get another data file or save the Experiment document.
Histograms

- creating and formatting histograms
- creating and formatting overlaid histograms
- adding, subtracting, scaling, and smoothing histograms
7.1 Creating Histograms

A histogram plot is a graphical means of presenting a single parameter of data. The horizontal axis of the graph represents the signal intensity of the parameter, and the vertical axis represents the number of events (counts).

Use the Plots menu or the Histogram tool to create histograms in CellQuest.

Perform the following steps to create a histogram.
Chapter 7: Histograms

1 Choose Histogram Plot from the Plots menu.

The Histogram Plot dialog box appears.

Alternately, you can specify the size and location of a histogram by selecting the Histogram tool from the tool palette. Using the Histogram tool:

- Click in an unused section of the Experiment document.
- Drag diagonally until the histogram outline is the desired size.

The Histogram Plot dialog box appears, allowing you to select histogram options.

2 Click Select File in the plot dialog box.

3 Click Open in the dialog box that appears to select a file for analysis.

4 Choose the parameter using the Parameter pop-up menu.

5 Choose a gate from the Gate pop-up menu.

You cannot apply a gate to data from a single-parameter histogram file. Gates are only available for multiparameter list-mode data.
Formatting a Histogram

Use the Histogram Plot dialog box to format a histogram.

1 Choose Y-Axis option.

   Click:
   • Log Y Axis, to change from linear to logarithmic scaling.
   • Manual Scale, to type a maximum Y-axis value from 1 to 32,000.

If neither box is checked, the y-axis automatically scales to the highest peak in the histogram.

2 Define Color.

   Click:
   • the Line color box to change the outline color. The Line Color Selection dialog box appears. Click the new color.
   • the Fill color box to change the fill color. The Fill Color Selection dialog box appears. Click the new color.

3 Choose a value for Smoothing under Modify Data.

   Enter a value from 0 (no smoothing) to 5 (maximum smoothing) in the highlighted field to decrease irregularities in the histogram profile.

4 Click OK.

   The histogram plot appears in the Experiment document.
Reformatting Histograms

Select a histogram plot, and choose the Format Histogram command in the Plots menu. Use the dialog box that appears to change any of the options associated with the histogram, including the data file. The dialog box is identical to the one that appears after initially opening a data file for histogram analysis.

Alternately, you can change a parameter directly on the plot itself by placing the cursor over the plot axis and clicking the mouse button to open a pop-up menu listing the parameters. See Section 3.1, Creating an Acquisition Plot.

7.2 Creating Overlaid Histograms

A plot with more than one histogram is an overlaid histogram plot. You can overlay histograms showing any parameter from any file. The initial histogram appears in the back, with the overlays in front in the order they were created. An overlaid histogram cannot be saved as an FCS file.

1 Select a histogram or overlaid histogram plot.

2 Choose Overlay from the Plots menu.
3 Click Select File from the Histogram Overlay dialog box that appears.

![Histogram Overlay Dialog Box]

4 Click the file to overlay in the dialog box that appears, and then click Open.

The Histogram Overlay dialog box reappears. The first four fields in this dialog box, Plot Source, File, Parameter, and Gate, describe the histogram to be added. Any changes to the fields in the lower half of the dialog box apply to all histograms in the overlaid histogram plot, with the exception of overlay color.
Chapter 7: Histograms

Formatting Overlaid Histograms

Use the Format Histogram Overlay dialog box to format an overlaid histogram.

1. Choose Overlay View.

   Click:
   - Normal, to display the histograms in a two-dimensional view.
   - 3D View, and enter values for Tilt and Rotation to see the plots in a three-dimensional view.
   - For Tilt, type a number between 0 and 90 degrees to set the tilt angle.
   - For Rotation, type a number between -360 and +360 degrees to set the rotation angle. The plot rotates around an imaginary axis at right angles to, and through the center of, the 3D plot grid.
   - The default rotation is 315; to rotate to the left, enter a number greater than 315; to rotate to the right, enter a number less than 315.
Figure 7-1 shows the same histogram in 2D and 3D view.

![Histograms](image)

**Figure 7-1** Overlaid histogram, 2D view (left) and 3D view (right)

NOTE: When the histogram is in 3D view, markers and regions are not shown and cannot be added.

2 Choose Overlay colors and line styles.

Click the Line or Fill color boxes to change these colors. The Color Selection dialog box appears. Click the desired color.

If you are using a black-and-white printer, click the Line Style box so the overlaid histograms will be printed in different line styles to differentiate them. A dialog box appears with 10 line style options. Click the desired style.

3 Choose Normalization.

Normalization applies only to the display of the data. It does not affect the actual number of events in a histogram.

Click:

- Global Maximum—to normalize the vertical scale to the highest value found in any histogram in the plot. All histograms appear in their true relation to each other.
Chapter 7: Histograms

- Each Histogram—to normalize each histogram to itself. Peak heights in each histogram do not necessarily appear in their true relation to other histograms.
- Manual Scale—to assign an absolute value to the vertical scale. Type a number from 1 to 32,767 in the designated field. All histograms appear in their true relation to each other.

4 Click OK.

The overlaid histogram appears in the plot.

Reformatting Overlaid Histograms

You can easily modify an overlaid histogram plot.

1 Click to select the plot.

2 Choose Format Histogram Overlay from the Plots menu.

The Format Histogram Overlay dialog box appears.

![Format Histogram Overlay dialog box](image)

This dialog box contains the same information as the Overlay Histogram dialog box, except that the file name, parameter, gate, color, and line style...
appear in a scrollable list. You cannot change data files, parameters, or gates from this dialog box, but you can change colors and line styles.

The options in the bottom half apply to all histograms in the overlay. Make modifications to your original choices here.

3 Format the overlays with the desired option.

Click the selection arrows and drag to change a histogram position in the overlay. The list is reordered, and the histograms are reordered in the overlay.

**Displaying Histogram Legends**

A legend applies only to overlaid histogram plots; it lists all histogram names, parameters, gates, and associated colors in the selected plot. Because of space constraints, individual histograms are not labeled in the plot; the legend allows you to identify the histograms.

1 Select an overlaid histogram plot.

2 Choose Legend from the Plots menu.

The histogram legend appears.

<table>
<thead>
<tr>
<th>Key</th>
<th>Name</th>
<th>Parameter</th>
<th>Gate</th>
</tr>
</thead>
<tbody>
<tr>
<td>NORM001</td>
<td>FL1-H</td>
<td>No Gate</td>
<td></td>
</tr>
<tr>
<td>NORM001</td>
<td>FSC-H</td>
<td>No Gate</td>
<td></td>
</tr>
</tbody>
</table>

You cannot edit this view. To delete the legend, select it and choose Cut or Clear from the Edit menu, or press Delete.
7.3 Using Histogram Tools

1. Click to select the plot.

2. Choose Histogram Tools from the Plots menu.

   The Histogram Tools dialog box appears.

3. Select the histograms you want to change by clicking the selection arrows.

   To select more than one histogram in the Histogram Tools box, click each histogram selection arrow while holding down the Command key (⌘) (discontinuous selection) or click the first histogram and last histogram in the list while holding down the shift key (continuous selection).

4. Choose a value for Smoothing Iterations.

   Click:
   - in the field and type a value from 0 (no smoothing) to 5 (maximum smoothing) to decrease irregularities in the histogram profile.
   - Smooth
5 Choose a value for Scale.

Click in the field and type a value from 0.1 to 99.9 to multiply the channel counts (number of events in each channel). Click Scale. New histograms replace the old ones. Scaling affects histogram and K-S statistics.

If you have histograms with different event counts and want to normalize them, you must use the Scale button. Consider the following example:

Histogram A has 10,000 events and histogram B has 8,000 events. Divide 8,000 by 10,000 to determine a scaling factor of 0.8. Select histogram A, enter 0.8 in the Scale by field, and click Scale. Now both histograms have 8,000 events and can be added or subtracted.

⚠️ CAUTION: Do not use Scale to adjust the y-axis height. Use the Format Histogram command under the Plots menu.

6 Choose to add or subtract channel counts.

Click:

- Add—to sum the channel counts. A third histogram is created that is the sum of the two added histograms. You must name and select a storage location for the added histogram. The original histograms are unchanged, and the new added histogram appears in the same plot. If two histograms with different parameters are added or subtracted, then the parameter in the histogram list will be undefined.

- Subtract—to subtract the channel counts. If the resulting channel count is a negative number, it is assigned a channel count of zero. You must name and select a storage location for the subtracted histogram. The original histograms are unchanged, and the new subtracted histogram appears in the same plot. The order in which the two histograms are selected is not important. The highlighted histogram nearer the bottom of the list will be subtracted from the one above it. Reorder the histogram list, if necessary, by clicking the selection arrows and dragging.
Chapter 7: Histograms

If you do not know the number of events in each histogram, you can display histogram statistics to obtain the counts.

You can calculate statistics on added and subtracted histograms. See Chapter 8, Histogram Statistics.

7 Click Delete to remove an overlaid histogram.

The files created by adding or subtracting histograms are not deleted; only the histogram images are removed from the plot.
8

Histogram Statistics

- changing log data units
- calculating means
- creating, changing, deleting, and copying histogram markers
- displaying Marker Lists
- histogram statistics
- overlaid histogram statistics
CellQuest Software Reference Manual

CellQuest creates statistics using information from the FCS data file. You must select a plot before you can use the first five commands in the Stats menu.

<table>
<thead>
<tr>
<th>Stats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Histogram Stats</td>
</tr>
<tr>
<td>K-S Stats...</td>
</tr>
<tr>
<td>Region Stats</td>
</tr>
<tr>
<td>Gate Stats</td>
</tr>
<tr>
<td>Quadrant Stats</td>
</tr>
<tr>
<td>Edit...</td>
</tr>
</tbody>
</table>

To maintain statistical veracity, you must follow these rules:

- Statistics text may not be modified in any way.
- Cut or copy an entire statistics view, but not the individual items in the view.
- To determine what information appears in each statistics view, use the Edit Stats menu item.

### 8.1 Log Data Units

The Log Data Units command in the Plots menu allows you to select between two methods of calculating and reporting statistics on logarithmically amplified data. The method you select applies to the entire Experiment document, not just a particular plot. The first method calculates and reports channel values; the second method calculates and reports linear values.

All calculations begin with a channel value (or number) because this is how the cytometer sends digital signals to the computer. Before deciding which method to choose for calculating and reporting, let's review the difference between channel value and linear value.

- The channel value corresponds to the data resolution value (0–255 or 0–1023).
• The linear value refers to the dynamic range of signal intensities (10^0–10^4 or 1–10,000).

If you select Channel Values as the method of calculation, the calculations are performed on the channel numbers and the results are expressed as channel values.

You may prefer to compare the relative intensities of logarithmically amplified signals by converting the channel value to a number that corresponds to the logarithmic scale. This converted number is referred to as a linear value. If you select Linear Values as the method of calculation, the channel numbers are converted to linear values using the following equation:

\[ \text{Linear value} = 10^{(\text{channel number/scaling factor})} \]

After the conversion, the statistics are calculated and the results are expressed as linear values.

**Changing Statistical Calculations**

1. Choose Log Data Units from the Plots menu to access the dialog box.

* For 256-channel resolution data, the scaling factor is 256/4 or 64. For 1024-channel resolution data, the scaling factor is 1024/4 or 256, where 4 is the number of log decades.
2 Click the radio button to change the current selection; then click OK.

All plot and statistics views are updated with the new values. Remember, this applies to log-amplified data only; linear-amplified data is unaffected.

### 8.2 Calculating Means

CellQuest calculates means and geometric means. Geometric means are preferable when dealing with skewed populations.

The formulas for mean and geometric mean are:

\[
\text{mean} = \frac{\sum X_i}{n}
\]

\[
\text{geometric mean} = 10^{\frac{\sum \log(X_i)}{n}}
\]

where \(X_i\) is the channel value or the linear value for the \(i\)th event and \(n\) is the number of events used in the calculation. Remember, for log data you may choose to calculate statistics on channel values or you may convert the channel values to linear values and then calculate the statistics; the formulas for mean are not affected by this choice.

The geometric mean can be calculated for any parameter regardless of the data mode, log or linear, and the log data units settings.

### 8.3 Histogram Markers

CellQuest calculates statistics for the entire histogram or for sections of the histogram. Each section includes a range of channels on the histogram x-axis. The sections are defined by setting histogram markers.

A marker, which is used to define a particular section of a histogram, consists of an upper and lower boundary connected by a horizontal line. When selected, the
marker appears with a handle at the intersection of the horizontal line and the vertical boundaries (Figure 8-1). The prefix M is the default label for histogram markers.

![Figure 8-1](image)

**Figure 8-1** Selected (M1) and deselected (M2) histogram markers

A marker generates statistics for the events in a designated section of the histogram. You can draw markers only on a single histogram plot or a 2D view of an overlaid histogram plot. You can define up to eight markers for each plot.

**Creating a Histogram Marker**

1. Select the Histogram Marker tool from the tool palette.

   ![Histogram Marker Tool](image)

2. Click to position the left edge of the marker and drag to position the right edge of the marker.

   As the cursor passes over the plot, its shape changes to a crosshair to indicate that you can define a histogram marker. The ribbon under the title bar
CellQuest Software Reference Manual

displays the channel number or linear value of the x-axis (X) and the count (Y). For overlaid histograms, the Y value is blank.

3 Release the mouse button to complete the marker.

The marker appears with a handle at each endpoint. The marker is also added to the Marker List.

4 To move a marker label, deselect the marker, and click and drag the label to its new location.

Moving a Histogram Marker

1 Click the horizontal line of the marker.

2 Drag the marker to its new location.

The Marker List is updated with the new location. Histogram statistics are updated.

Resizing a Histogram Marker

1 Click the marker to select it.

2 Click on a handle and drag the marker's edge to its new location.

The Marker List is updated with the new location. Histogram statistics are updated.

Displaying a Marker List

1 Select a histogram plot.

The Marker List applies to that plot only.
Chapter 8: Histogram Statistics

2 Choose Marker List from the Gates menu.

The Marker List window appears.

You can copy, paste, delete, reorder or give a new label to a marker on the Marker List.

To select a marker, click its selection arrows. To select more than one marker, click each marker label while holding down the shift key. To select more than one marker in the Marker List, click each marker selection arrow while holding down the Command key (⌘) (discontinuous selection) or click the first marker label and last marker label in the list while holding down the shift key (continuous selection). To deselect a marker, click its selection arrows while holding down the ⌘ key.

Since each histogram plot can have its own markers, you can open a Marker List for each histogram plot in each Experiment document.

Deleting a Marker

1 Select the marker in the Marker List or in the plot.
2 Choose Cut or Clear from the Edit menu, or press Delete.

   If you delete a marker from the Marker List, it is automatically deleted from
the plot. If you delete a marker from the plot, it is automatically deleted
from the Marker List.

Copying a Marker

You can select one or more markers to copy and paste to another plot. There are
two ways to copy a marker: copy the image of the marker from a plot, or copy
the definition of the marker from the Marker List. There are also two ways to
paste a marker: paste into a plot, or paste into the Marker List. If you paste an
image, the definition is automatically added; if you paste a definition, the image
is automatically drawn.

1 Select the marker to be copied from the histogram plot or in the Marker
List.

2 Choose Copy from the Edit menu.

   The marker is copied to the Clipboard.

3 Click the plot or the Marker List where you want to paste the marker.

4 Choose Paste from the Edit menu.

   The marker appears in the plot and is added to the Marker List if a marker
with the same name does not already exist and there are less than eight
markers already defined. If you copied more than one marker to the
Clipboard, none of the markers in the Clipboard will be pasted if there is not
enough room in the Marker List for all of them. The two plots do not need
to have the same axis parameters.
Chapter 8: Histogram Statistics

Copying Markers to Regions

Markers can be converted to regions that can be used to define gates. Remember, markers provide statistics for histograms; regions are components of gates used to define subpopulations of events.

1. Select the marker to be copied in the histogram plot or in the Marker List.

2. Choose Copy from the Edit menu.

3. Choose Region List from the Gates menu.

4. Choose Paste from the Edit menu.

The information is added to the Region List if a region with the same name does not already exist and there are fewer than sixteen regions already defined. Its image, however, is not drawn on any plots. If you copied more than one marker to the Clipboard, none of the markers in the Clipboard will be pasted if there is not enough room in the Region List for all of them.

If you copy marker M1 to the Region List, its label is still M1, not R1. The default in the Gate List is G1=R1. Therefore, to use M1 in gates, either change the label in the Region List to R1, or change the definition in the Gate List to M1.
8.4 Displaying Histogram Statistics

You can display histogram statistics and determine which statistics to display by choosing Histogram Stats from the Stats menu.

<table>
<thead>
<tr>
<th>Stats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Histogram Stats</td>
</tr>
<tr>
<td>K-S Stats...</td>
</tr>
<tr>
<td>Region Stats</td>
</tr>
<tr>
<td>Gate Stats</td>
</tr>
<tr>
<td>Quadrant Stats</td>
</tr>
<tr>
<td>Edit...</td>
</tr>
</tbody>
</table>

Your selections in the Edit Histogram Statistics dialog box determine which statistics appear. Undefined values are represented by *** in the statistics views.

1. Select a histogram plot.
2. Choose Histogram Stats from the Stats menu.

The Histogram Statistics view appears.
8.5 Editing Histogram Statistics

You determine what information appears in the statistics view by using the Edit Histogram Statistics command in the Stats menu.

Up to three custom keywords can be displayed in each statistics view. The default is to display none. A custom keyword with its value is displayed if you have defined it. For example, if you select Custom Keyword #1 in the Edit Histogram Statistics dialog box, but you have not defined that keyword, then it will be displayed as Custom Keyword #1: with no value following.

To select which statistics appear in the statistics view:

1. Click the view to select it or make it active.
2. Choose Edit Histogram Stats from the Stats menu.

The Edit Histogram Statistics dialog box appears.
3 Click the checkboxes of the items you want to appear in the statistics view.

Choose to display any combination of these options:

**Header Info**

- **Title Line**: Labels the view with *Histogram Statistics*.
- **File Name**: Name of data file.
- **Log Data Units**: Units used for calculating and displaying statistics, either linear values or channel numbers.
- **Sample ID**: Sample identification.
- **Patient ID**: Patient identification.
- **Patient Name**: Patient name.
- **Case Number**: Case number.
- **Tube**: Tube name.
- **Panel**: Panel name.
- **Acquisition Date**: Date file was acquired or created.
- **Gate**: Gate label or *No Gate*, depending on whether a gate was applied.
- **Total Events**: Total number of events in the data file.
- **Gated Events**: Number of events in the gate applied to the data file.
- **Parameter**: Histogram x-axis parameter and its data mode (linear or log).
- **Smoothing Iterations**: Always reads zero because statistics are calculated on unsmoothed data.
### Statistics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marker Label (Marker)</td>
<td>Marker label from marker list.</td>
</tr>
<tr>
<td>Marker Bounds (Left, Right)</td>
<td>Locations of the left and right boundaries.</td>
</tr>
<tr>
<td>Event Count (Events)</td>
<td>Number of events in each marker of the selected histogram.</td>
</tr>
<tr>
<td>Percent of Gated (% Gated)</td>
<td>Percentage of the events in a marker compared to the total number of events within the gate.</td>
</tr>
<tr>
<td>Percent of Total (% Total)</td>
<td>Percentage of the events in a marker compared to total events in the data file.</td>
</tr>
<tr>
<td>Mean</td>
<td>Average channel number or linear value of events within a marker.</td>
</tr>
<tr>
<td>Geometric Mean (Geo Mean)</td>
<td>Average of the logarithm of the channel numbers or linear values of the events within a marker, expressed as the anti-log.</td>
</tr>
<tr>
<td>SD</td>
<td>Standard deviation, a measure of the spread about the mean for events within a marker.</td>
</tr>
<tr>
<td>CV</td>
<td>Coefficient of variation, the SD divided by the mean within a marker, expressed as a percentage.</td>
</tr>
<tr>
<td>Median</td>
<td>Channel number or linear value that divides a histogram in the marker into two parts with equal numbers of events.</td>
</tr>
<tr>
<td>Peak</td>
<td>Number of events at the highest point within the marker.</td>
</tr>
<tr>
<td>Peak Channel (PeakCh)</td>
<td>Channel number or linear value of the peak within a marker.</td>
</tr>
</tbody>
</table>
Live Stats Events

Calculation of Live Stats (Last Second or Cumulative)  Calculate live statistics for the last second or cumulative; disabled when selected view is in Analysis mode; default setting is Last second.

Header Columns

Number of Columns (1 or 2)  Specify 1 or 2 header columns for an individual view; default setting is 2 Columns.

4 Click OK in the dialog box.

The statistics view does not automatically resize itself when statistics are deselected. You can resize it by dragging the selection handles. The new size is remembered when you get another data file or save the Experiment document.

8.6 Overlaid Histogram Statistics

There are two statistical options that apply only to overlaid histograms. One option allows you to select different histograms for the numerator and denominator used in calculating percent gated and percent total. The other, the Kolmogorov-Smirnov statistics option, is a test that two histograms come from the same populations.

Percent Total and Percent Gated Calculations

The percent gated is calculated by taking the number of events within the marker and dividing by the number of events in the gate that was applied to the data. The percent total is calculated by taking the number of events within the marker and dividing by the number of ungated events in the underlying list-mode data.
Chapter 8: Histogram Statistics

For example, assume you have an FCS list-mode data file that contains 10,000 events. You can create a histogram that contains 8000 events by gating the list-mode data. If you create a marker that encloses 2000 events, you get the following percentage statistics for the marker:

\[
\text{percent gated} = \left(\frac{2000}{8000}\right) \times 100 = 25\%
\]
\[
\text{percent total} = \left(\frac{2000}{10,000}\right) \times 100 = 20\%
\]

You can also express the number of events in a marker of one histogram as a percentage of a second histogram. In other words, you can do the same calculations for percent gated and percent total, but use the number of gated and total events from a different histogram as the denominators in the equations.

A common use of this feature involves subtracted histograms. The overlaid histogram plot in Figure 8-2 shows a control histogram (NORM001) that is subtracted from another histogram (NORM002) to create a third histogram (NORM002–NORM001). See Section 7.3, Using Histogram Tools.

![Subtracted histogram example](image)

**Figure 8-2** Subtracted histogram example

Histograms must be overlaid in the same plot to be subtracted. To better illustrate the subtraction, **Figure 8-3** shows the two component histograms and the resulting subtracted histogram in separate plots.
Figure 8-3 Control histogram (left), test histogram (center), subtracted histogram (right)

To express the NORM002–NORM001 histogram as a percentage of the NORM002 histogram, perform the following steps.

1. Select the plot and choose Histogram Stats from the Stats menu.

The Histogram Statistics dialog box appears.
Chapter 8: Histogram Statistics

2 Select the numerator (NORM002–NORM001) and denominator (NORM002) histograms, click OK, and the Histogram Statistics view appears.

**NOTE:** Remember, the selection of numerators and denominators only affects the percent gated and percent total in overlaid histograms; other statistics are not affected.

**Kolmogorov-Smirnov (K-S) Two-Sample Test**

The Kolmogorov-Smirnov (K-S) two-sample test is used for overlaid histograms. The calculation computes the summation of the curves and finds the greatest difference between the summation curves. You can calculate K-S statistics for the whole histogram or for a portion by setting a marker. Both histograms must have the same data mode, logarithmic or linear. Smoothing and scaling affect K-S statistics.

**Displaying K-S Statistics**

1 Select an overlaid histogram plot.
2 Choose K-S Stats from the Stats menu.

The Kolmogorov-Smirnov Statistics dialog box appears.

3 Select the two histograms to compare by clicking their names while holding down the Command key (⌘).

You can also select a marker to restrict the range over which the statistics are calculated.

4 Click OK, and the Kolmogorov-Smirnov Statistics view appears.
Chapter 8: Histogram Statistics

The following statistics are reported:

- **Channels**: The portion of the histogram used in the analysis.
- **D/s(n)**: An index of similarity for the two curves. If $D/s(n) = 0$, the curves are identical. In this equation, $s(n)$ equals the square root of $(n_1 + n_2)/(n_1 \cdot n_2)$, where $n_1$ is the number of events in the first histogram and $n_2$ is the number of events in the second histogram.
- **D**: The Kolmogorov-Smirnov statistic; simply, the greatest difference between the two curves.
- **Channel**: Channel number of D.
- **P Value**: The probability of $D$ being as large as it is given that the two selected histograms are from the same population.

For a complete discussion of these statistics, refer to the article written by IT Young in the *Journal of Histochemistry and Cytochemistry*. 1977;25:935-941.
Regions and Gates

- creating histogram regions
- creating rectangular, elliptical, polygonal regions
- changing, deleting, and copying regions
- using the Region List
- defining a gate
- displaying the Gate List
- using multicolor gates for dot plots
- using Auto Recalculate
A region is a boundary you draw around a subpopulation of events on a plot. You can define up to sixteen regions in each Experiment document and use them to define gates. Regions cannot be drawn on a 3D contour plot or a 3D view of an overlaid histogram plot.

### 9.1 Histogram Regions

Histogram regions are created, moved, and resized in the same way histogram markers are, except you use the Region tool from the tool palette instead of the Marker tool. Histogram regions are used to define subpopulations of data for analysis and to define gates, while histogram markers are used to generate statistics. As Figure 9-1 illustrates, histogram regions are labeled with the prefix R.

![Labeled histogram region](image)

#### Creating a Histogram Region

1. Select the Histogram Region tool from the tool palette.
2 Click to position the left edge of the region, and drag to position the right edge of the region.

As the cursor passes over the plot, its shape changes to a crosshair to indicate that you can draw a region. The ribbon under the title bar displays the channel number or linear value of the x-axis (X) and the event count (Y) as you draw a region.

3 Release the mouse button to complete the region.

The region appears with a handle on each endpoint. The region is also added to the Region List.

Moving and Resizing a Histogram Region

1 Click the horizontal line of a region to select it.

Handles appear when the region is selected. See Figure 9-1.

2 To move the region, click and drag it to a new location.

3 To resize the region, click on a handle and drag the edge to its new location.

9.2 Rectangular, Elliptical, and Polygonal Regions

Draw a region on a dot, density, or contour plot by enclosing a subpopulation of events using one of three tools from the tool palette. Use the Rectangular Region tool to create a square or rectangular region. Use the Elliptical Region tool to create a circular or elliptical region. Use the Polygonal Region tool to create a free-form region.
Figure 9-2 shows these three types of regions.

![Rectangular, elliptical, and polygonal regions](image)

**Figure 9-2** Rectangular, elliptical, and polygonal regions

### Creating a Rectangular or Elliptical Region

1. Select the Rectangular- or Elliptical-Region tool from the tool palette.

2. Position the cursor in a dot, density, or contour plot and click and drag diagonally until the region is the desired shape.

As the cursor passes over the plot, its shape changes to a crosshair. As you are drawing the new region, it appears as a dotted outline. The ribbon under the title bar displays the x and y location of the cursor as you draw a region.

When you have completed the region, it appears as a solid outline with a handle on each corner. These handles indicate the region is selected.

### Creating a Polygonal Region

1. Select the Polygonal-Region tool from the tool palette.

2. Position the cursor in a dot, density, or contour plot and click to designate the starting point.

A vertex appears.
Chapter 9: Regions and Gates

3 Move the cursor to the next position and click to add another vertex of the polygon region.

A solid line appears connecting the two vertices.

NOTE: To restart or cancel the region after setting the first vertex, click outside the plot view.

4 Repeat step 3 until you have drawn the desired shape.

Click the first vertex to complete the polygon.

You can also double-click the mouse button to set the last vertex and complete the polygon. When you have completed the region, it appears as a solid outline with handles on the corners of the rectangle circumscribing the polygon. These handles indicate the region is selected.
NOTE: The region can only be concave in one direction (X or Y) as shown in Figure 9-3. CellQuest prevents you from adding a vertex that would create an illegal shape or rotating the polygon into an illegal shape.

![Figure 9-3 Concave polygon in x and y directions](image)

**Editing a Polygonal Region**

You can edit the shape of a polygon region, but you cannot add a vertex.

1. Select the polygon.

2. Choose Edit Polygon from the Gates menu, or double-click the polygon.

The selection handles are now on the vertices of the polygon, not the corners of the rectangle circumscribing the polygon.

![Figure 9-4 Deselected polygon (left), selected polygon (center), edit-mode polygon (right)](image)
Chapter 9: Regions and Gates

3 Click and drag a vertex to the desired position.

To exit the edit mode, deselect the region or choose Stop Editing Polygon from the Gates menu.

**Moving and Resizing a 2D Region**

1 To move a region, click on the region anywhere except on a handle.

2 Drag it to its new location.

The region automatically becomes selected when it is clicked. Region statistics are updated.

3 To resize a region, select the region; then click a handle and drag to the desired size.

The Region List is updated with the new location. Region statistics are updated.

4 To move a region label, deselect the region, and click and drag the label to its new location.

**Rotating a 2D Region**

1 Select the region.

All regions except histogram regions can be rotated.

2 Choose Rotate Region from the Gates menu or press and hold the Command key (⌘).
3 Click and drag one of the handles.

The region rotates around the center of the region, not the handles. To exit the rotate mode, deselect the region or release the Command key (⌘) or choose Stop Rotating Region from the Gates menu. Region statistics are updated.

9.3 Displaying a Region List

1 Activate an Experiment document.

The Region List applies to the associated Experiment document, rather than to a single plot.

2 Choose Region List from the Gates menu.

The Region List window appears with the name of the associated Experiment document. This window has two sizes and shows the name of the associated Experiment document.
Chapter 9: Regions and Gates

On the Region List, regions can be deleted, copied and pasted, given a new label, or reordered.

- To select a region, click its selection arrows.
- To select more than one region, click each region label while holding down the shift key. To select more than one region in the Region List, click each region selection arrow while holding down the Command key (⌘) (discontinuous selection) or click the first region label and last region label in the list while holding down the shift key (continuous selection).
- To deselect a region, click its selection arrows while holding down the ⌘ key.

Regions are named in numerical order, R1 through R16. When you delete a region, the next region you define is given the lowest R number available. For example, if you have R1, R2, and R3 defined, and you delete R2, the next region you define is R2.

9.4 Deleting a Region

You can delete a region image from a plot and a region from the Region List, but the results are different. If you delete a region image from a plot, the image is removed only from that one plot; the region is not deleted from the Region List or any other plots. If you delete a region from the Region List, its definition is removed from the Region List and any plots where it appears.

Deleting a Region from a Plot

Click the region to select it, and choose Cut or Clear from the Edit menu or press Delete. The region no longer appears in the view, but still appears in the Region List. This means the region is still defined and can be copied and pasted back into that plot or into another plot with the same parameters.
Deleting a Region Definition

1. Choose Region List from the Gates menu.

2. Select the region to be deleted from the Region List by clicking the selection arrows.

   The entire row becomes highlighted.

3. Choose Cut or Clear from the Edit menu or press Delere.

   The region is removed from the Region List and from any plots where it appears. Any gate that uses the region becomes invalid. Any plot or statistic that uses the invalid gate is affected. In plots, data passing through an invalid gate is not shown. In statistics views, data from an invalid gate is either undefined (denoted as *** or 0, depending on the statistic. For example, the total events can be 0, but the CV cannot be 0 and is therefore undefined.

   To summarize, a region is deleted if its definition is deleted from the Region List. If a region’s image is deleted from the plot, it is not deleted from the Region List. To replace the region in the plot, select the region in the Region List, copy it, then paste it into the plot. Another way to replace the region in the view is to copy and paste the same region from another plot.

9.5 Copying and Pasting a Region

One or more regions can be selected and copied to the Clipboard. There are two ways to copy a region: copy the definition of the region from the Region List, or copy the image of the region from a plot. There are also two ways to paste a region: paste the copy into a plot, or paste the copy into the Region List.

Keeping in mind that an Experiment document has only one Region List, you can copy a region definition and paste it into:
Chapter 9: Regions and Gates

- another plot with the same parameters in the same Experiment document. The region is drawn in the plot. The region is already defined in the Region List, so there are no changes to the Region List.

- a plot in a different Experiment document. The region is drawn in the plot and the definition is added to the Region List if there is room.

- a Region List in a different Experiment document. It is added to the list if there is room, but no images are drawn.

In addition, you can copy a region image and paste it into:

- another plot with the same parameters in the same Experiment document. The region is drawn in the plot. The region is already defined in the Region List, so there are no changes to the Region List.

- a plot in a different Experiment document. The region is drawn in the plot and the definition is added to the Region List if a region does not already exist with the same name and if the limit of sixteen regions has not been exceeded. None of the regions in the Clipboard will be pasted if there is not enough room in the Region List for all of them.

- a Region List in a different Experiment document. It is added to the list if there is room, but no images are drawn.

In summary, if you are copying a region from one Experiment document to another and are pasting into a plot, the image is drawn and the definition added. If you are pasting into the Region List, the definition is added but the image is not drawn.

To copy and paste a region:

1. Select either the region in a plot or the region in a Region List.

To select more than one region in a plot, click each region while holding down the shift key. To select more than one region in the Region List, click each region selection arrow while holding down the Command key (⌘).
(discontinuous selection) or click the first region and last region in the list while holding down the shift key (continuous selection).

2 Choose Copy from the Edit menu.

3 Activate the destination plot or Region List, and paste the region in the desired location.

Keep in mind the following:
- A histogram region cannot be pasted into a two-parameter plot.
- A region cannot be pasted into a plot in a different Experiment document if the region has the same name as a region in the other document.
- You cannot have more than sixteen regions in each Experiment document.

9.6 Renaming a Region

You can rename a region using up to 40 characters. By default, the region number and the region label are the same, R1 through R16. The region number cannot be changed, but the label can be. The region label, not the region number, is recognized by the gate list. For example, if you change the label of R1 to Lymphocytes, the gate list automatically changes R1 to Lymphocytes. If you then want to use R1 in a gate, you must use the new label, Lymphocytes, not R1, in the gate definition.

NOTE: If the region label consists of two or more words with spaces between the words, quotation marks are automatically put around the words in the gate list. This allows the software to determine where the region label starts and ends. If you want to define a gate in the gate list using a region labeled with more than one word, you must put quotation marks around the label.

1 Choose Region List from the Gates menu.
Chapter 9: Regions and Gates

2. Double-click a Label field.

3. Type the new label, using up to 40 characters.

4. Click anywhere off the Label field to complete the entry, or press Tab or Return.

The new name appears in the gate list.

Changing the Order of a Region List

You can change the order of the regions listed on a Region List.

- Choose Region List from the Gates menu.
- Click the selection arrow of the region you want to move and drag up or down to the new position on the list.

9.7 Defining a Gate

A gate, which is a combination of regions, is used to isolate subsets of data. Use the logical operators AND, OR, and NOT to combine regions. Combine regions into gates using these logical operators or their equivalent symbols:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>R1 AND R2</td>
<td>An event that satisfies both R1 and R2 satisfies the gate, that is, AND is equivalent to *</td>
</tr>
<tr>
<td>R1 * R2</td>
<td>An event that satisfies both R1 and R2 satisfies the gate, that is, AND is equivalent to *</td>
</tr>
<tr>
<td>R1 OR R2</td>
<td>An event that satisfies either R1 or R2 satisfies the gate, that is, OR is equivalent to +</td>
</tr>
<tr>
<td>R1 + R2</td>
<td>An event that falls outside R1 satisfies the gate, that is, NOT is equivalent to –</td>
</tr>
<tr>
<td>NOT R1</td>
<td>An event that falls outside R1 satisfies the gate, that is, NOT is equivalent to –</td>
</tr>
<tr>
<td>−R1</td>
<td>An event that falls outside R1 satisfies the gate, that is, NOT is equivalent to –</td>
</tr>
</tbody>
</table>
The operator NOT only modifies the region it refers to; it does not combine regions. Therefore, unless NOT appears at the beginning of a gate definition, it must be preceded by a region along with AND or OR.

Consider the following examples:

- NOT R1 is valid
- R1 NOT R2 is invalid
- R1 AND NOT R2 is valid

You must insert spaces between the logical operators and the definitions. For example, CellQuest cannot recognize R1ANDR2, but does recognize R1 AND R2. If the region label consists of more than one word, put quotation marks around the label in the gate list.

The logical operators are applied in this order: NOT, then AND, then OR. You can use parentheses to change this order. The operations and regions in parentheses are read first, before the other operators. Here are three examples:

1. NOT R1 AND R2. CellQuest first reads NOT R1, and then AND R2: all events outside R1 and also in R2.
   - NOT (R1 AND R2). CellQuest first reads R1 AND R2, and then applies NOT: all events outside the intersection of R1 and R2.

2. R1 OR R2 AND R3. CellQuest first reads R2 AND R3, and then R1 OR: all events in both R2 and R3 or events in R1.
   - (R1 OR R2) AND R3. CellQuest first reads R1 OR R2, and then AND R3: all events in either R1 or R2 and also R3.

3. R1 OR G2 OR NOT R3 AND R4. CellQuest first reads NOT R3, then reads AND R4, and then R1 OR G2.
Chapter 9: Regions and Gates

- (R1 OR G2 OR NOT R3) AND R4. CellQuest first determines the events within the parentheses, using the normal order of operations. Then it reads these events and R4.

You can use a logical gate in the definition of another logical gate, for example, R1 and G2. You can use the same region or logical gate any number of times in a logical gate definition. You can copy regions from one Experiment document to another, but you cannot copy gates.

9.8 Displaying a Gate List

Use a Gate List to label, define, and display up to sixteen gates for an associated Experiment document.

- Gates are initially defined to correspond to region numbers: G1 is defined as R1, G2 is R2, and so on.
- If you rename a region, the Gate List is updated.
- For a gate to be valid, the regions that comprise it must be valid, or defined.
- All labels and definitions of invalid gates are italicized.

1 Choose Gate List from the Gates menu.

The Gate List window appears. This window has two sizes (Figure 9-5) and shows the name of the associated Experiment document

- To select a gate, click its selection arrows.
- To select more than one gate, click each gate label while holding down the shift key. To select more than one gate in the Gate List, click each gate selection arrow while holding down the Command key (⌘) (discontinuous selection) or click the first gate and last gate in the list while holding down the shift key (continuous selection).
- To deselect a gate, click its selection arrows while holding down the Command key (⌘).
2 Double-click the Definition field.

3 Type the gate definition.

When you rename a region, remember to use the region label, not the region number.

Figure 9-5 Gate List window, two sizes
Chapter 9: Regions and Gates

Copying a Gate

Gates cannot be copied. However, the text of a gate label or definition can be cut or copied and pasted into another Gate List. The regions that comprise the gate are not copied when you copy the text of a gate label or definition.

Changing the Order of a Gate List

You can change the order of the gates listed on the Gate List.

1. Choose Gate List from the Gates menu.

2. Click the selection arrow of the gate you want to move and drag up or down to the new position on the list.

9.9 Using Multicolor Gates for Dot Plots

For dot plots, you can use the multicolor option to color events that satisfy gates in the Gate List without actually gating the data. See Section 5.3, Formatting CellQuest Plots. This allows you to visually compare subpopulations that appear in different dot plots.

When you select multicolor gating for a dot plot, the events take on the colors of the gates listed in the Gate List according to the following conditions:

- For each event, CellQuest scans down the Gate List, starting with the first gate listed at the top. An event is drawn in the color of the first valid gate that is satisfied and that has its multicolor checkbox checked.
- If a given event does not satisfy any of the gates in the gate list, it will take on the color of the gate for the dot plot.
- An event is drawn in the color selected for Single Color if it does not satisfy any other gate in the list, and there is no gate for the dot plot.
Figure 9-6 illustrates multicolor gating using two dot plot views of the same data and the associated Gate List, using data file NORM003 from the CellQuest Sample Files folder.

![Multicolor gating example](image)

**Figure 9-6** Multicolor gating example

On the two plots, lymphocytes, monocytes, and granulocytes are colored according to which gates they satisfy. Notice that the population in G4 is not colored because the multicolor checkbox is unchecked in the Gate List. The invalid gates in the Gate List are not used for coloring even though their multicolor checkboxes are checked.

NOTE: You can reorder the gates in the Gate List to change the gate hierarchy, or priority (and therefore the color) of the events in multicolor dot plots.
Setting Up a Gate List for Multicolor Gating

1. Choose Gate List from the Gates menu.

2. Click the check boxes, if unchecked, to select gates for multicolor.

3. Click the color box to change the color of the gate, if desired.

   The Color Selection dialog box appears with the 24 color choices. Click the color to make your selection. The new color appears in the color box.

9.10 Recalculating Data

When you start CellQuest for the first time, all calculations are automatic. This means that immediately after you make changes in an Experiment document, CellQuest calculates any items affected. You can set calculation to occur only when you want by turning off the Auto Recalculate feature in the Gates menu. This allows you to delay certain time-consuming updates until you are ready. This is the manual mode of recalculation.

Turning Auto Recalculate off suspends some operations that trigger processing of list-mode data. These operations include the following:

- changing the data of a plot
- changing the parameter of a plot
- changing the color of a gate
- adding, deleting, or altering regions and gates

Operations not affected by the calculation mode include moving, resizing, and zooming plots.

NOTE: Some operations cause a partial update of information. For example, if you change the data file of a dot plot while Auto Recalculate is turned off, the plot axis and title update, but the data in the plot does not update.
The Recalculate feature on the Gates menu consists of two menu items: Auto Recalculate and Recalculate Now (\(\text{Ctrl}=\)).

When Auto Recalculate is turned on, a check mark appears in front of its name in the pull-down menu and Recalculate Now is not enabled. When Auto Recalculate is turned off, no check mark precedes its name and Recalculate Now is enabled if something is waiting to be recalculated. When in the manual mode, the calculations are kept in a processing queue until Recalculate Now is chosen or Auto Recalculate is turned back on.

When there are items to be updated, the calculator tool in the tool palette is enabled.

You can click this tool to force a recalculation. Clicking the tool is equivalent to choosing Recalculate Now from the menu. Recalculate Now applies to the active Experiment document only.

NOTE: Because some information in the Experiment document may not be valid when items are awaiting updates, printing, Export Stats, and Append Stats are not enabled. After recalculating the data, these items are once again enabled.
Quantitative Calibration

- overview of quantitative calibration
- setting up for quantitation
10.1 Brief Overview of Quantitative Calibration

Traditional analysis paradigms in flow cytometry include: a) percent positives and negatives based on an isotype control, and b) absolute counts (cells/μL) using a known number of reference beads. The continuum of fluorescence staining intensities from the negative to the brightly positive is often expressed in relative terms as *dim* and *bright*. Quantitation, the expression of the staining intensity levels in terms of fluorophores per cell, can provide a more meaningful classification of data. Quantitation of fluorophores is a necessary first step in the assessment of antigen density on cells. Other antigen-specific parameters, for example, epitopes per antigen and epitopes bound per antibody, and variables associated with sample preparation, such as avidity and concentration, must be controlled as well.

Quantitation can be done using QuantiBRITE™ beads with a known number of PE molecules for each of four bead populations. By plotting the logarithm of the geometric means of FL2-H of the four bead populations against the logarithm of the number of PE molecules per bead, a linear regression can be done on the data to get the equation:

\[ y = mx + c \]

where \( m \) is the slope of the regression line and \( c \) is the \( y \)-intercept.

![Linear Regression Graph](image)

This equation is then used to transform FL2-H into the number of PE molecules for a series of assays. Refer to the QuantiBRITE PE product data sheet.
10.2 Setting Up CellQuest for Quantitative Calibration

While CellQuest cannot use the regression equation to transform FL2-H, you can use the Quantitative Calibration command in the Acquire menu to calculate the regression line and save the slope and intercept information in data files for use in other applications.

The Installer places a Quantitation Acquisition document in the Sample Files folder in the CellQuest application folder. See Section 1.2, Installing the Software.

1. Launch CellQuest.

2. Open the Quantitation Acquisition document.

This document (Figure 10-1) was installed in the Sample Files folder (in the CellQuest Folder in the BD Applications folder) during installation of CellQuest software.

Notice that the document contains:

- an acquisition to analysis dot plot of FSC-H vs SSC-H with a region for the bead singlets
• an acquisition to analysis histogram plot of FL2-H gated on bead singlets
• a Histogram Statistics view

Figure 10-1  Quantitation Acquisition document

3 Customize your template.

Add plots to this document that you will use to optimize the cytometer and to acquire data for your cellular sample.

Save your modified Experiment document.

4 Place your cellular sample on the sample injection port (SIP) and optimize the instrument settings. Save an instrument settings file.

Using Setup mode, adjust all the parameters for your cellular assay. Make sure the instrument is compensated properly. See Chapter 3, Preparing for Acquisition, and see Chapter 4, Acquiring Data.
5 Prepare the QuantiBRITE bead sample according to the package insert and place it on the SIP.

You can change the FSC and SSC parameter settings to gate on bead singlets without altering quantitation. All instrument settings for fluorescence and compensation must be the same as the cellular assay settings.

6 Adjust the region in the scatter plot over the singlet bead populations.

Figure 10-2 Gating on bead singlets

7 Uncheck Setup in the Acquisition Control window, and acquire a data file of 10,000 events.

8 Adjust the markers in the histogram over each bead peak.

Figure 10-3 FL2-H histogram plot with markers

The statistics will be updated after adjustments have been completed.
Select the Histogram Statistics view (FL-2 beads).

Choose Quantitative Calibration from the Acquire menu.

The Quantitative Calibration window appears.

Enter the lot-specific values provided on the flyer packaged in the QuantiBRITE PE kit.

Click Copy Means on the Quantitation Calibration window.

The geometric means in the selected Histogram Statistics view are copied to the Quantitation Calibration window. The Copy Means button is enabled only when you have selected one FL2-H Histogram Statistics view and that statistics view displays all four of the following:
Chapter 10: Quantitative Calibration

- analysis statistics, not live statistics
- the geometric mean column
- exactly four markers, not including the All marker
- Log Data Units set to Linear Values

When you click Copy Means, the geometric means for the four markers in the view are sorted and copied in to the Geometric Mean column of the Quantitative Calibration window. The statistics data file name is also displayed.

**13 Click Calibrate.**

CellQuest performs the regression analysis and displays the results in the Slope, Intercept, and R-Squared fields as illustrated in Figure 10-4.

![Figure 10-4 Results displayed in Quantitative Calibration window](image)

Once you click Calibrate, do not click the Copy Means button again or change a PE molecule value. If you do either one, the results are presented as ***, or undefined values, and you will have to redo the calibration.

You can print the active Quantitative Calibration window. Choose Print from the File menu.
14 Save your Experiment document.

When you save an Experiment document used to perform quantitative calibration, the PE molecules per bead values you entered in the Quantitative Calibration window are saved; the mean and regression results are not saved, however. You must recalculate to get the calibration information when you reopen the document for further data file acquisition.

If the Quantitative Calibration window contains defined values when the calibration process is complete, the quantitation information is saved in all subsequently acquired data files.

15 Acquire your cellular samples.

You must use the same instrument settings and the same Experiment document.

Data files saved using this document will contain new keywords in the text sections which define the results of the calibration. If you use a different document to collect your data files, the keywords will not be present in the file text section.
Appendix A

Tutorial

This tutorial introduces you to some basic features of CellQuest software. You will perform a typical dot plot and a histogram analysis procedure on sample data files that were installed with the software. A more detailed description of all the options available for each type of plot is provided in relevant chapters.
A.1 Dot-Plot Analysis

Immunophenotyping is a good example of an application that uses dot-plot analysis. In this example, cells have been stained with fluorochrome-conjugated monoclonal antibodies and the data acquired on a flow cytometer. The list-mode data can be displayed as dot plots and a gate can be set around a population of interest. By setting a statistical marker on a negative control sample, subsequent samples can be evaluated using the same gate and marker.

During this tutorial, you will analyze two sample data files. The files are found in the Sample Files folder which was installed in the CellQuest folder with the software. These files contain data from a panel of four reagents.

<table>
<thead>
<tr>
<th>Sample 1</th>
<th>Reagents</th>
<th>Sample 2</th>
<th>Reagents</th>
</tr>
</thead>
<tbody>
<tr>
<td>NORM001</td>
<td>Control</td>
<td>NORM005</td>
<td>Control</td>
</tr>
<tr>
<td>NORM002</td>
<td>CD3/CD19</td>
<td>NORM006</td>
<td>CD3/CD19</td>
</tr>
</tbody>
</table>

Using these files, you will:

- set a light-scatter gate to isolate lymphocytes
- set a marker on a control plot
- analyze two-color data from three patients
- print your results
- use the Next Data File command to quickly analyze the next file set
- save your work as an Experiment document
Creating a Dot Plot

1. Choose CellQuest from the Apple menu to launch the application.

2. Click the zoom box in the upper-right corner to expand the Experiment window.

3. Select the Dot-Plot tool from the tool palette to highlight it.

4. Click in a clear area of the Experiment window, and drag diagonally until the plot outline is the desired size.
CellQuest Software Reference Manual

5 Click Select File in the Dot Plot dialog box that appears.

![Dot Plot dialog box]

An Open Data File dialog box appears.

6 Navigate to the Sample Files folder located in the CellQuest Folder in the BD Applications folder.

A list of available files appears in the window.

![Open a Data File dialog box]

7 Select NORM001 and click Open.

The Dot Plot dialog box appears again.
Appendix A: Tutorial

8 Verify that the X Parameter is FSC and the Y Parameter is SSC.

Make any changes using the X and Y parameter pop-up menus.

![Dot Plot dialog box](image)

9 Click OK on the Dot Plot dialog box.

An FSC vs SSC dot plot of NORM001 appears with a frame surrounding the plot.

The appearance of the frame indicates the state of the plot. When handles appear on each corner of the frame, the plot is selected. When the frame is gray, the plot is active.

- Click on the frame to select a plot.
- Click anywhere on a plot except its frame to activate a plot.
- Click outside a plot to deselect it. The frame is clear (no handles).

Figure A-1 displays examples of the three frame states. See Section 2.1, The Experiment Document.
Figure A-1  Active plot (left), selected plot (center), deselected plot (right)

Setting a Gate

1  Click the Rectangular Region tool in the tool palette.

2  Position the cursor on the dot plot, and click and drag diagonally to create a region to isolate lymphocytes.

The region outline is dotted while being formed and solid with a handle at each vertex when complete. These handles indicate the region is selected (Figure A-2).

- To select a region, click the border. To deselect a region, click outside the region.
- To delete a region from a plot, select it, choose Cut or Clear from the Edit menu, or press Delete. The region no longer appears in the view but still appears in the Region List. See Chapter 9, Regions and Gates.
- To adjust the position of the region, click anywhere on the region outline except on a handle and drag to the desired location.
Appendix A: Tutorial

- To adjust the size of the region, select it, click any handle, and drag in or out to the desired size.
- To reposition the region label R1, click outside the plot to deselect the region, and click and drag the label R1 to its new location on the plot.

![Region with handles](image)

**Figure A-2** Region with handles

### Applying the Gate on a New Plot

1. Choose Dot Plot from the Plots menu.
   
   The Dot Plot dialog box appears.

2. Click Select File.
   
   The Open a Data File dialog box appears.

3. Click Open to open data file NORM001.

4. Choose FL1 for the X parameter and FL2 for the Y parameter from the Parameter pop-up menus.

   NOTE: You can change parameters directly on the plot in the Experiment document using the cursor to access a pop-up menu for each parameter. See Section 3.1, Creating an Acquisition Plot.
5 Choose G1 (Gate 1) from the Gate pop-up menu.

Gate 1 by default is defined as Region 1, the region you just created. Figure A-3 shows a completed Dot Plot dialog box.

![Dot Plot dialog box](image)

**Figure A-3** Dot Plot dialog box (completed)

6 Click OK.

The gated FL1 vs FL2 dot plot appears in the Experiment document. This is the negative control sample. It is used for determining nonspecific staining and for setting a quadrant marker for the statistical analysis of the rest of the samples. Notice that the plot size is the same as the first dot plot you drew using the tool palette (step 4).

When you use the Plots menu to create a plot, CellQuest places the first plot in the upper left corner of the Experiment document and staggers subsequent plots. Move the second plot off the first plot by clicking its frame and dragging.
Setting a Quadrant Marker

1. Click the Quadrant Marker tool in the tool palette.

2. Click in the FL1 vs FL2 plot and drag to position the quadrant marker so the lower-left quadrant is near the border of the population.

   Release the mouse button when you are satisfied with the quadrant marker setting.

   ![Quadrant markers placed](image)

   **Figure A-4** Quadrant markers placed

   A marker is two solid lines with a handle at the intersection. To change the position of a marker, click on the handle and drag to a new location. A plot can have only one quadrant marker. To delete a marker, click the intersection to select it, and choose Cut or Clear from the Edit menu, or press Delete.

3. Choose Quadrant Stats from the Stats menu while the plot is active.

   A Quadrant Statistics view appears (Figure A-5) with descriptive and statistical information about the plot.
Analyzing the Remaining Files in the Panel

The plots and statistics for the remaining data files in the panel will not all fit on a one-page document. You must increase the size of the document to accommodate additional plots and statistics views.

1. Choose Document Size from the File menu.

The Document Size dialog box appears.
Appendix A: Tutorial

2 Click the square to the right of the highlighted square, and click OK.

The document increases to two pages. A dotted line appears on the document, showing where page breaks will occur during printing. It also shows page numbers.

3 Display file NORM002 as an FL1 vs FL2 dot plot using Gate 1.

4 Click the quadrant marker in NORM001 at the intersection to select it, and choose Copy from the Edit menu.

5 Click plot NORM002 to activate it, and choose Paste from the Edit menu.

The quadrant marker is pasted into the plot.

6 Choose Quadrant Stats from the Stats menu.

The Quadrant Statistics view appears.

Printing the Results

1 Choose Print (⌘ P) from the File menu.

A printer-specific dialog box appears.
2 Click Print.

    Alternately, choose Print One from the File menu to automatically print a
    single copy of the active document; no Print dialog box appears. Choose
    Print One only if you do not need to define printing specifications.

So far, you have

- set a lymphocyte gate
- set a quadrant marker
- displayed statistics
- analyzed two files with the gate and markers
- printed your results

Because you can select more than one plot at a time and get the next data
files in CellQuest, it is easy to repeat this analysis for the next files.

Analyzing the Next Files

1 Choose File Increment from the Plots menu.

    The File Increment dialog box appears.

    ![File Increment Dialog Box]

2 Type 2 in the Next File Increment field, and click OK.
Appendix A: Tutorial

3 Select all the views by choosing Select All from the Edit menu.

All the plot and statistic views now have handles. Make sure no plot or view is active before choosing Select All. If a plot is active when you choose Select All, everything within that plot is selected.

4 Choose Next Data File from the Plots menu.

All plots and statistics in the Experiment document are automatically updated with the new files. NORM001 is incremented to NORM003; NORM002 is incremented to NORM004, and so on. Verify that the gate and markers are appropriate for the next files.

As you can see, after you set up the Experiment document with the plots, gates, markers, and statistics you want, it is easy to repeat the analysis for subsequent files. Gates and markers can be modified for each file.

5 Choose Save from the File menu.

The Save dialog box appears.

6 Name your document Analysis 1, choose a folder location for it, and click Save.

A.2 Histogram Analysis

Creating a Histogram

1 Choose New from the File menu.

A new document, Untitled-2, covers the previous one.
2 Select the Dot-Plot tool from the tool palette.

3 Click in a clear area of the Experiment window and drag diagonally until the plot outline is the desired size.

A Dot Plot dialog box appears.

4 Click Select File.

The Open Data File dialog box appears.

5 Navigate to the Sample Files folder located in the CellQuest Folder in the BD Applications folder.

A list of available files appears in the dialog box window.

6 Select NORM001 and click Open.

The Dot Plot dialog box appears again.
Appendix A: Tutorial

7 Verify that the X Parameter is FSC and the Y Parameter is SSC.
Make any changes using the X and Y parameter pop-up menus.

8 Click OK on the Dot Plot dialog box.
An FSC vs SSC dot plot of NORM001 appears with a frame surrounding the plot.

9 Choose Analysis 1 from the Windows menu.

10 Select Region 1 in the FSC vs SSC plot for NORM001.
Handles appear on the region.

11 Choose Copy from the Edit menu.

12 Choose Untitled-2 from the Windows menu.

13 Activate the FSC vs SSC plot.

14 Choose Paste from the Edit menu.
The same region used for NORM001 in the Analysis 1 document is now pasted into the FSC vs SSC plot in the Untitled-2 document and Region 1 is also added to the Region List of the Untitled-2 document.

15 Choose Histogram Plot from the Plots menu.
The Histogram Plot dialog box appears (Figure A-6).
Figure A-6 Histogram Plot dialog box

16 Click Select File.

The Open a Data File dialog box appears.

17 Click Open to open data file NORM001.

The Histogram Plot dialog box appears.

18 Choose FL1 from the Parameter pop-up menu.

19 Choose G1=R1 from the Gate pop-up menu.

20 Click OK.

The FL1 histogram of NORM001 appears (Figure A-7) with fluorescence intensity along the x-axis and counts along the y-axis.
Setting a Histogram Marker

21 Click the Histogram Marker tool in the tool palette to select it.

22 Click in the plot to position the left edge of the marker at the origin. Drag to position the right boundary of the marker at the edge of the population.
23 Release the mouse button to complete the marker.

The marker appears with a handle at each endpoint and the marker label M1. The handles indicate the marker is selected.

- To delete a marker, click to select it and choose Cut or Clear from the Edit menu or press Delete.
- To move a marker, click the horizontal line of the marker and drag to the new location.
- To resize a marker, click to select it, click a handle, and drag the marker's edge to the new location.
- To reposition the marker label M1, click outside the plot to deselect the marker, and click and drag the label M1 to its new location on the plot.

24 Repeat steps 21 through 23 to define another marker.

Place the second marker from the right edge of Marker 1 to the far right edge of the histogram.

![Histogram with markers M1 and M2](image)

25 Choose Histogram Stats from the Stats menu.

The Histogram Statistics view appears (Figure A-8) with descriptive and statistical information about the plot.
**Appendix A: Tutorial**

All is automatically defined as the entire histogram.

![Histogram Statistics view](image)

**Figure A-8** Histogram Statistics view

26 Display file NORM002 as a gated FL1 histogram. (Repeat steps 15 through 20.)

27 Select both markers in the first histogram by holding down the Shift key and clicking each one.

28 Choose Copy from the Edit menu.

29 Click NORM002 histogram plot, and choose Paste from the Edit menu.

   The histogram markers are pasted into the NORM002 histogram plot.

30 Choose Histogram Stats from the Stats menu.

   Histogram statistics for the new histogram are also displayed.

**Printing the Results**

1 Choose Print (⌘P) from the File menu.

   The Print dialog box appears.
2 Choose the printing specifications you want.

3 Click Print.

Alternately, choose Print One from the File menu to automatically print a single copy of the active document; no Print dialog box appears. Choose Print One only if you do not need to define printing specifications.

Analyzing the Remaining Files

Change the File Increment to 2, and select all the plots. Using the Next File keystroke (⌘), move through the files, analyzing as you go.
Appendix B

Command Key Equivalents
Command key equivalents, also known as keyboard shortcuts, are combinations of key presses that you can use instead of mouse actions to perform a task. They are convenient alternatives to using the mouse to choose menu commands. They appear in the pull-down menus next to their menu items.

### From the File menu

- To open a new Experiment document: `⌘N`
- To open a saved Experiment document: `⌘O`
- To close the active Experiment document: `⌘W`
- To save the active Experiment document: `⌘S`
- To append statistics to an exported file: `⌘T`
- To print the active Experiment document: `⌘P`
- To quit CellQuest: `⌘Q`

### From the Edit menu

- To undo the most recent change: `⌘Z`
- To cut an item to the Clipboard: `⌘X`
- To copy an item to the Clipboard: `⌘C`
- To paste an item from the Clipboard: `⌘V`
- To select all items in the active document or view: `⌘A`
- To access the Text Settings dialog box: `⌘T`
Appendix B: Command Key Equivalents

From the Cytometer menu

To open the Detectors/Amps window

To open the Threshold window

To open the Compensation window

To open the Status window

From the Plots menu

To reformat the selected plot

To change the data file for the selected plots

To get the next data file for the selected plots

To get the previous data file for the selected plots

From the Gates menu

To open the Gate List window

To recalculate any data in the Experiment document

From the Batch menu

Run

From the Acquire menu

To connect/disconnect the cytometer
Glossary

active window  The front-most window on the desktop; the window where the next action will take place. An active window title bar is highlighted.

analysis  The software function of numerically and graphically manipulating data to generate statistics.

annotation  A label or comment read from a data file and displayed in the experiment document.

Clipboard  An area in the computer memory that functions as a holding place for what was last cut or copied.

coefficient of variation (CV)  The standard deviation of the data divided by the mean of the data; typically expressed as a percentage. When applied to channel data measured on a population of cells, the CV is a measure of variation independent of the population mean.

contour plot  A graphical presentation of two-parameter data in which contour lines show the distribution of events. Similar to a topographical map, the contour lines show event frequencies as peaks and valleys.

data file  A collection of measured values from a single sample combined with text describing the sample that has been stored to disk. See also list-mode file.
CellQuest Software Reference Manual

dot plot A graphical means of representing two-parameter data. Each axis of the plot displays values of one parameter. A dot represents an event (particle).

Experiment document A collection of gates, plots, regions, statistics, and text, defined by the user.

Experiment window The frame for viewing parts of an Experiment document.

FCS See Flow cytometry standard.

Flow cytometry standard Standard format for flow cytometer data files.

gate A combination of one or more previously defined regions that define a subset of the total sample population. The logical operators AND, OR, and NOT, along with parentheses, if necessary, are used to define logical gates.

histogram A graphical means of presenting single-parameter data. The horizontal axis of the graph represents the increasing signal intensity of the parameter, and the vertical axis represents the number of events (counts).

list-mode file An unprocessed data file containing all of the measured parameters for each particle in the sample, as well as information describing the sample.

marker A lower and upper boundary on a histogram that allows you to obtain statistics for a particular section of a histogram.

mean channel The average channel number of a sample from a population of cells.

parameter A measurement of a cell property which is ascertained as the cell passes through the laser beam. Each parameter is the output of a single photomultiplier tube or photodiode, measuring fluorescent or scattered light.

peak The number of events in the peak channel.
**Glossary**

**peak channel**  The channel number containing the maximum number of events in a marker.

**Read Me file**  A file copied with CellQuest to your hard disk that includes additional information not included in the manual.

**region**  A boundary drawn around a subpopulation to isolate events for analysis. Regions can be combined to create gates.

**single parameter (SP) file**  A file that contains event counts for only one parameter.

**threshold**  A trigger signal and level of discrimination to eliminate unwanted events. Only events with parameter values above the threshold will be analyzed.

**tool palette**  A collection of tools used for creating plots, markers, regions, free text, and recalculation.
Index

numerals
2D region
  moving, resizing 173
  rotating 173–174
3D plot 94
  formatting 103–104
3D-Plot tool, defined 40

a
Acquire menu 47–61
  accessing quantitative calibration 189
  Acquisition & Storage 48–51
  Connect to Cytometer 61
  Counters 55–57
  Custom Keywords 54–55
  Edit Panels 58–61
  Edit Reagent List 57–58
  Parameter Description 52–54
  Quantitative Calibration 61
acquisition
  choosing panels for 60
  ending 89
  starting 82–84
acquisition control, hiding 35
acquisition plot, creating 44–47
  changing parameters 46
acquisition services, installing 14–15
acquisition to analysis plots 86–88
  parameter numbering 86–88
amplifier gains, changing 62–63
Arrow tool, defined 41
assistance, technical viii

b
banner, adding 32–34
Batch menu 113–116
  Run 116
  Setup 114–115
BD Applications folder 12, 13–14
calculating means 150
calculations, percent gated 160–163
calculations, percent total 160–163
Calculator tool, defined 41
CellQuest files 25
CellQuest software
  hardware requirements 10
  installing 11–14
  launching 15
  quitting 17
  registering 16–17
  running with modem 10
  setting up for quantitative calibration 189–194
  software requirements 10
  using file sharing 10
  with FACS Vantage 69–74
  with FACStarPLUS 75–79
color palette 30–32
command key equivalents 216–217
compensation, adjusting 64
computer requirements 10
contour plots
defined 92–93
  formatting 98–100
Contour-Plot tool, defined 40
control histogram 162
custom keywords, creating 54–55
cytometer
   checking status 79–80
   connecting to 61
Cytometer menu 61–67
   Compensation 64
   Detectors/Amps 62–63
   Instrument Settings 65–66
   Status 66–67
   Threshold 63–64
data files
   changing 107–108
   displaying next or previous 108–112
data, recalculating 185–186
density plots
   defined 93
   formatting 47, 100–102
Density-Plot tool, defined 40
dot plots
   defined 92
   formatting 46–47, 97–98
   using multicolor for 183–185
Dot-Plot tool, defined 40
Edit menu 28–34
   banner 32–34
   color palette 30–32
   text settings 28–30
   editing statistics 126–132, 157–160
   elliptical region 169
   creating 170
Elliptical-Region tool, defined 41
EvE INIT 12, 13, 14
Experiment document 20–23
   adding banner 32–34
   adding color 30–32
   adding text 116–119
   printing 27
   setting text 28–30
   using as template 42
   views 21–22
F
   FACS Vantage, with CellQuest 69–74
   FACSCalibur, with CellQuest 67–69
   FACSsort, with CellQuest 67–69
   FACStarPLUS, with CellQuest 75–79
   FCS file
      saving overlaid histogram as 137
   FCS files, saved by CellQuest 25
File menu 24–28
   append statistics 26
   document size 26
   export statistics 25
   Print One 27
   file sharing
      using with CellQuest 10
folders
   BD Applications 12, 13–14
   CellQuest 13–14
   Sample Files 13, 14
   formatting options
      density plots 47
dot plots 46–47
   histograms 47
   gate list
      displaying 181–183
      setting up for multicolor gating 185
Index

gate list, displaying changing order of 183

h
hardware requirements 10 histogram legends, displaying 142 histogram markers. See markers, histogram. histogram statistics, displaying 156 histogram tools, using 134, 143–145 Histogram-Region tool, defined 41 histograms creating 134–137 formatting 47 histograms, creating displaying legends 142 formatting 136, 139–141 overlaid 137–142 reformatting 137, 141–142 using histogram tools 143–145

i
INITs 11 installing software. See CellQuest software. instrument settings printing 66 restoring 66 saving 65

k
Kolmogorov-Smirnov test. See K-S two-sample test.

K-S two-sample test 163–165
Statistics view 164 statistics, displaying 163–165

l
launching software. See CellQuest software. legends, displaying histogram 142 Log Data Units 148–150 changing statistical calculations 149–150

m
overlaid histogram statistics 160–165
K-S two-sample test 163–165
percent total, percent gated 160–163
overlaid histograms, creating 137–142

page breaks, showing 35
panels, editing 58–60
adding new 58–59
adding new tube 59
changing panel or tube name 59
changing parameter label 59
deleting panel or tube 60
duplicating panel or tube 60
reordering panels or tubes 59
parameter numbering 86–88
percent gated calculations 160–163
percent total calculations 160–163
plots
acquisition to analysis 86–88
changing axes 107
time-dependent 88–89
Plots menu 44
Log Data Units 148–150
plots, acquisition
changing parameters 46
creating 44–47
formatting options 46–47
plots, CellQuest
3D 94
contour 92–93
creating 95–96
deleting or copying 105–106
density 93
dot 92
formatting 97–106
reformatting 104–105
zooming in and out 119–120

PMT detector voltages, changing 62–63
polygonal region 169
creating 170–172
editing 172–173
Polygonal-Region tool, defined 41
printing, Experiment document 27
Print One 27

Quadrant Marker tool 122
Quadrant Marker tool, defined 40
quadrant markers 122–124
copying 123–124
creating 122–123
deleting 123
QuantiBRITE beads, using. See quantitative calibration.
quantitative calibration 61, 188–194
overview 188
QuantiBRITE beads, using 188, 191
Quantitation Acquisition document 189–190
setting up CellQuest for 189–194

Reagent List, editing 57–58
rectangular region 169
creating 170
Rectangular-Region tool, defined 41
Region List
changing order 179
displaying 174–175
regions
copying and pasting 176–178
creating histogram 168–169
creating polygonal 170–172
deleting 175–176
moving, resizing histogram 169
renaming 178–179
registering software. See CellQuest software.
requirements, hardware and software 10
ribbon 23

S
Sample Files folder 13, 14
Sample Injection Port 82
security module 10
attaching 11–12
initialization file 13
Selection tool, defined 40
SIP. See Sample Injection Port.
size box 23
snap to grid command 36
software requirements 10
sorting 67–69
statistical calculations, changing 149–150
statistics, displaying 124–126, 156
gate 124, 131
live 84–85
quadrant 124, 130
region 124, 131
statistics, editing 126–132, 157–160
statistics, histogram
displaying 156
editing 157–160
statistics, overlaid histogram 160–165
K-S two-sample test 163–165
percent total, percent gated 160–163
Stats menu 84, 124–126, 148
quadrant statistics 125
region, gate statistics 125–126

T
technical assistance viii
templates, using Experiment documents 42
text settings 28–30
Text tool, defined 41
text, adding to Experiment document 116–119
threshold, changing 63–64
time-dependent 88–89
title bar 23
tool palette 23, 39–41
tools defined 40–41
tool palette, hiding 34
tools. See tool palette.
tutorial 196–214
dot-plot analysis 196–207
histogram analysis 207–214

V
views, Experiment document 21–22

W
Windows menu 34–38
grid 36–37
hide acquisition control 35
hide palette 34
show page breaks 35
snap to grid 36
viewing open windows 38

Z
Zoom-In tool, defined 40
Zoom-In tool, using 119–120
Zoom-Out tool, defined 40